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Welcome! 
  

Welcome to Allplan Building Cost Management, Nemetschek's 
integrated program for tendering, awarding and invoicing. 

Thank you for choosing Allplan Quantities, which allows you to 
prepare detailed specifications and building descriptions quickly, 
easily and in a transparent manner. This way, you can immediately 
see how cost and quality interact. 

Allplan Quantities assists you in calculating building costs based on 
the conventional or advanced element method. A comprehensive 
element catalog complete with the latest building prices is already 
included in Allplan Quantities for your convenience. 

Integrated interfaces ensure that you can easily import predefined 
data as well as exchange data with Nemetschek's Allplan CAD 
system and other tender, contracting and costing products. 

With the "DIN 276" option, you can also analyze and evaluate your 
project data based on DIN 276-compliant cost groups. 

  

We wish you fun and success with Allplan Quantities! 

Your Allplan BCM Team 
Nemetschek Allplan Systems GmbH, Munich 
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General Information 
This chapter provides detailed information on: 

 The system requirements the computer must meet to 
ensure proper operation of Allplan BCM 

 The sources of information provided by the Allplan 
BCM user documentation and other media 

 The contents of this manual 

 The basic terminology, conventions and abbreviations 
used in the Allplan BCM user documentation 

 What to do if you need assistance 
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Allplan Quantities System Requirements 
The requirements for running Allplan Quantities are basically the 
same as for any of the Microsoft Windows versions listed in the table 
below. 

If your computer is running smoothly under one of these Windows 
versions, you will have no problems installing and working with 
Allplan Quantities. 

 

Allplan Quantities requires the following minimum system 
configuration: 

System component ... recommended ... 

Processor Intel Core 2 (or compatible) 

RAM 2 GB 

Hard disk space 5 GB 

Screen resolution 1280 x 1024 

Network card (for networked 
workstations) 

100 MBit/s 

Software (standard) Windows 8 or 
Windows 7, SP 1 or 
Windows Vista, SP 2 

Software (terminal server) Windows Server 2012 or 
Windows Server 2008 R2, SP 1 

 

 

Basic rule: The higher the 
hardware performance, the 
more effectively you can use 
Allplan Quantities! 
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The Allplan Quantities Documentation 
The Allplan Quantities documentation consists of the online 
documentation (manual in PDF format) and the online help. 

You can use either component to become familiar with Allplan 
Quantities. Choose the one that suits you best. 

  

Online documentation 

The online documentation consists of a set of manuals in PDF 
format. In contrast to printed manuals, these "electronic manuals" 
offer the advantage that you can access the complete contents of the 
user documentation for Allplan Quantities straight from your 
workstation anytime. 

You can open the online documentation in two ways: either by clicking 
Manuals on the program’s Help menu or straight from the Allplan DVD 
by selecting Documentation in the DVD Content column and clicking 
Allplan BCM). Whichever method you choose, you need Adobe Acrobat 
Reader to open the files. 

This manual is designed to give you a quick and practical introduction 
to Allplan Quantities. Therefore, it conveys the essentials in a compact 
form. As the key focus of this manual is on the basics, the individual 
topics are outlined only briefly. Solutions for specific problems and 
descriptions of the settings and parameters can be found in the 
online help. 

  

Online help 

Allplan Quantities provides an extensive online help system covering 
the entire range of modules and functions in the program. While you 
work with Allplan Quantities, you can get help on the current function 
or situation by pressing the F1 KEY or activate Contents and index 
on the Help menu and point to the icon on which you require help. 

The Help window shows information on commands, detailed step-
by-step instructions for all the tools, information on basic concepts 
and terms and much more. 
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The index provides a convenient way of looking up topics on which 
you require help. In addition, you can use the integrated search tool 
to quickly find related Help topics. 

The quickest and easiest way to get started with Allplan Quantities is 
Easy2Learn. This quick guide outlines the most important steps in 
each tendering and cost calculation phase on a separate help page. 
All you have to do is ... 

 
  

 
 



 

Integrated solutions  General Information 5 
 

Terminology 
  

The table below provides explanations for the main terms used in the 
documentation. As these terms describe important operations, it is 
essential that you are familiar with these expressions in order to 
work with the software. 

Expression Meaning 

ALT KEY The Alt key on the keyboard. For controlling 
special functions, this key is used in 
combination with other keys. 

Activate You activate/deactivate an option by clicking 
its check box. Activated options are 
indicated by check marks. 

Select You select a function by opening a menu 
and clicking a command. You can also open 
a menu or select a command/option by 
pressing the ALT key and the underlined 
letter of the menu/command. 

PAGE UP KEY You use the "Page " key on the keyboard 
to control the section displayed on screen. 

PAGE DOWN KEY You use the "Page " key on the keyboard 
to control the section displayed on screen. 

Data field Fields provided for entering data into the 
data sheets. 

Double-click Point to an icon, menu or command and 
quickly push the left mouse button twice. 

Insertion marker Vertical, blinking bar indicating the point 
where the program expects you to make an 
entry. 

ENTER The ENTER key on the keyboard. In some 
cases, you need to press this key in order to 
confirm your entries. 

DEL KEY The Del key on the keyboard. If no characters 
are selected, pressing this key deletes the 
character to the right of the insertion marker. 
If characters are selected, pressing this key 
deletes these characters. 
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Expression Meaning 

ESC KEY The Esc key on the keyboard is usually used 
to cancel a function or command without 
performing the relevant operation. 

Click Point to an icon, menu or command and 
quickly push the left mouse button. 

Mark Drag the cursor over several elements (e.g. a 
number of letters or words) or double-click 
an element. In the case of menus or list 
boxes, elements are marked by clicking. 

ARROW KEYS The arrow keys on the keyboard. Small 
arrows and the names of the keys (LEFT, 
RIGHT, UP, DOWN) indicate the direction of 
movement. 

Button A switch, button or icon (usually denoted by 
a symbol or text) displayed in a dialog box. 
Clicking a button executes a command. 

CTRL KEY The Ctrl key on the keyboard. For controlling 
special functions, this key is used in 
combination with other keys. 

TAB KEY You can use the "" key on the keyboard 
to position the insertion marker on a tab. For 
controlling special functions, this key is used 
in combination with other keys. 

SHIFT KEY The "" key on the keyboard is used to 
change the case (lowercase to uppercase and 
vice versa). In combination with other keys, 
this key is also used for controlling special 
functions. 

Point to Move the mouse/cursor to an element 
displayed on screen (e.g. a button or menu). 

Cursor or mouse You use the cursor/mouse to position the 
insertion marker or to select a command. 

Drag Point to an element (e.g. a border of a 
window), press and hold the left mouse 
button and then move the mouse (do not 
release the mouse button!). 
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Conventions 
  

The following conventions apply to the entire documentation. Please 
read these conventions as they make the documentation quick and 
easy to use: 

Character Meaning 

ATTENTION! Please carefully read and follow the advice 
provided in "ATTENTION!" sections in order 
to prevent data loss or other serious 
problems. 

ALT Key names are written in capital letters. 

ALT+D Key combinations are represented by a "+" 
character. These keys need to be pressed 
simultaneously. Here, press and hold the ALT 
key while pressing the D key. 

File Names of menus, commands, buttons, icons, 
titles, windows, text in dialog boxes etc. – in 
other words, all the elements in templates 
and windows – are shown in bold. 

C:\WIN Messages issued by the operating system and 
entries you need to make at the operating 
system level are shown in Courier font. 
You need to press the ENTER key to confirm 
these entries. 

"Dear customer" (Variable) entries you make in data sheets, 
data fields, lines etc. – in other words, all 
user entries – are enclosed in quotation 
marks. 

Memo Options in list boxes and non-variable 
entries in data sheets, data fields, lines etc. – 
in other words, all entries controlled by the 
program – are shown in bold. 

Note: These sections provide additional 
information on the current topic. 

Important! Please pay special attention to sections 
marked as "Important!" as they provide 
essential advice and information. 
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If you need assistance ... 
  

... you will find the necessary information in the online help and the 
online documentation (see "The Allplan Quantities Documentation" 
on page 2). In addition, the status bar displays brief information 
about the individual tools on the menus. 

If you have further questions, our Technical Support will be glad to 
help you. You can benefit from the services provided by the 
Technical Support free of charge for the first three months after 
purchase of the first license. When you conclude a Serviceplus 
agreement, you do not have to pay for these services even after 
expiration of this period. 

Before contacting the Technical Support, please make a note of the 
precise wording of the error message including all numbers and 
abbreviations. To avoid unnecessary questions and delays, try to 
identify the problem as well as you can. 

The Technical Support sometimes requires detailed information on 
the hardware and configuration of your computer. You should 
therefore use the Technote program to generate support requests. 

You can reach the Technical Support at the Nemetschek Technology 
Center in Munich from Monday to Friday from 8 a.m. to 6 p.m. 

Phone:  0049 89 / 9 27 93 - 88 88 

Fax:      0049 89 / 9 27 93 - 88 09 
  

… and you have a Serviceplus agreement: 

For Serviceplus customers, any support provided by the Technical 
Support is free of charge! If you have any questions pertaining to the 
program, please send an email to our Technical Support team: 

support@nemetschek.de 

The Technical Support can also be contacted by phone or fax using 
the numbers above. 
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Furthermore, you can also refer to Nemetschek’s serviceportal 
Allplan Connect. In addition to a huge knowledge database, the 
serviceportal Allplan Connect provides you with the latest Line-
Letters and other helpful information. And you can communicate 
and exchange information with countless other users. 

To access Allplan Connect, all you need to do is register:  

connect.allplan.com 

  

… and you do not have a Serviceplus agreement: 

If you have not yet concluded a Serviceplus agreement after the free 
3-month support period, you can purchase Technical Support tickets 
for your support requests through our online shop. More information 
can be found on our website: 

www.nemetschek.de/services/support 

Even if you do not have a Serviceplus agreement, you have access to 
some areas of the serviceportal Allplan Connect. All you need to do 
is register: 

connect.allplan.com 
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The "Technote" program ... 
  

... is a useful aid not only for you, but also for the Technical Support 
to determine the basic configuration of your hardware and software 
environment. 

Technote generates a list of your computer's configuration and 
assists you in editing the AUTOEXEC.BAT, CONFIG.SYS, 
NEMMAN.INI and ALLRIGHT.INI system files. The printed report 
contains all the data required for solving hardware and software 
problems. 

  

To start the "Technote" program 

1 Click Start on the Windows task bar and point to Programs. 

2 Point to Nemetschek, select Allplan BCM and then click 
Technote. 

  

To print a Technote document 

1 Start the Technote program. 

2 Click Support request. 

3 Enter contact data.  

Important! 
Please fill in all the boxes; the Technote document cannot be 
printed otherwise. 

4 Do not activate the Include configuration files option unless the 
Technical Support asks you to.  

5 Enter your question or describe your problem in 3. Enter your 
support request. 

6 Click Output. 

7 Select the type of output/printout by clicking the relevant button 
in the Output dialog box. 
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Installing Allplan BCM 
This chapter shows how to install 

 Allplan BCM on a standalone workstation 

 Allplan BCM on a network and 

 the sample projects provided on the Allplan DVD. 
 

Information on Allplan BCM Setup 
All Allplan BCM program modules are installed using the Allplan 
BCM Setup program. Allplan BCM Setup automatically prompts you 
for the information it needs during the installation: 

• the drive on which you want to install the Allplan BCM program 
files (about 200 MB disk space) 

• the drive on which you want to install the Allplan BCM data 
management (at least 200 MB disk space; 25 MB additionally for 
demo data) 

• your license information (license disk, license file or license 
code). 

When you are installing the program for the first time, Allplan BCM 
Setup also automatically installs some of the sample projects that are 
provided on your Allplan DVD. If you would like to load additional 
sample projects, simply use the archive administration in Allplan 
Quantities (see "Demo Data for Allplan Quantities" on page 189). 

Before starting the installation, please make sure that there is enough 
free disk space on the drives you want to use. Also check that at 
least 30 MB free disk space is available on the drive on which you 
have installed your Windows system programs (= system drive). 

Important! 
Allplan Quantities Version 2014 supports installation on any of the 
operating systems listed in the "Allplan Quantities System Requirements 
(on page 1)" chapter. Please ensure that the most recent service packs 
are installed. 
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Installing Allplan BCM on a Standalone 
Workstation 

The Allplan BCM Setup program offers you a quick and easy way  
to install the individual Allplan BCM program modules on your 
computer. 

To install Allplan BCM on a standalone workstation 

1 Close all running applications. 

2 Log on as system administrator. 

3 Insert the Allplan DVD into your DVD drive. 

The start menu of the Allplan 2014 DVD opens automatically. 

4 Click Programs in the DVD Content column on the left. 

5 The Programs column is displayed. Click Allplan BCM. 

6 In the first dialog box, select a language for the setup process and 
for the program's user interface. 

Note: You can change the user interface language of the installed 
program any time (Extras menu -> Settings). 

 

Select a language and click OK. 
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7 Read the information in the Welcome dialog box. 

 

8 Click Next. 

9 The Software License Agreement dialog box (not shown here) 
appears. Please read the license agreement carefully. 

Click Yes to accept the license terms. 

10 Activate the Standalone workstation radio button in the 
Installation type dialog box and click Next. 

 

11 Select the license you want to use in the Select License 
Information dialog box. 

Insert the license disk into the drive or click  and select the 
folder containing the license file. 
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12 Click Next. 

13 In the Select program folder dialog box, select a program group 
for Allplan Quantities and click Next. 

 

14 Choose the Allplan BCM program modules you want to install. 

Activate the appropriate check boxes in the Components dialog 
box and click Next. 

 

15 The Select path dialog box appears. Specify the drives and 
directories where you want to install the individual Allplan 
Quantities components. 

Tip: You can choose different 
drives and directories for 
programs and data. This is 
usually only necessary, 
however, when you install 
Allplan Quantities on a 
network. 
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Important! 
If you have already installed a different Allplan BCM program 
module, leave the default path settings unchanged. This way you 
ensure that all files are copied to the correct directories. 

To change a default path, click the  icon next to it. 

 

16 Check the information given below each directory path to make 
sure that there is enough free disk space available. 

17 Click Next to continue with the installation. 

18 Please check all your entries carefully before starting the 
installation. 

 

19 Click Install when the displayed data is correct. 

This starts the installation process during which the files are 
copied to your computer's hard disk. 
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20 Please read the notes in the Information dialog box. 

 

Then click Next to continue. 

21 Allplan BCM Setup issues the following message when the 
installation has been successfully completed: 

 

Click Exit in the confirmation dialog box. 
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Installing Allplan BCM on a Network 
Allplan BCM is installed on a network in basically the same way as 
on a standalone workstation. The only differences are the installation 
type setting (standalone/network), which also determines the amount 
of files copied to the hard disk, and the settings for the path 
structure. 

Important! 
Installing Allplan BCM on a network requires an in-depth knowledge 
of the network software and the path structure on the network. 
Therefore, the installation should only be performed by the system 
administrator for the network. 

When running Allplan BCM on Windows, it is recommended to 
provide each workstation with its own local hard disk on which 
Windows is installed. This increases processing speed and saves 
network resources, particularly regarding swap files. 

If no local hard disks are available, proper network installation of 
Windows is indispensable. Besides the Windows directory of the 
basic installation, which contains the shared Windows files, you 
need to provide a separate Windows directory for each workstation. 
There you store the Windows files (e.g. INI files) that are specific to 
that workstation. The Windows network installation should also only 
be performed by the system administrator for the network. 

The following steps describe the most common network installation 
procedure (data on server, programs and local working directory on 
clients); other constellations are of course also possible provided the 
required network knowledge is available. 

To install Allplan BCM on a network 

1 First install the server. 

Proceed as described in steps 1 to 9 in the "Install Allplan BCM 
on a Standalone Workstation" section. 

2 In step 10, activate the Server installation radio button in the 
Installation type dialog box and click Next. 
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3 Select the license you want to use in the Select License 
Information dialog box. 

Insert the license disk into the drive or click  and select the 
folder containing the license file. 

4 Click Next. 

5 The Select path dialog box appears. Enter the network drive on 
the server as the data directory. 

6 Proceed from step 15 in the "Install Allplan BCM on a Standalone 
Workstation" section to complete the server installation. 

Important! 
In the above procedure, no Allplan BCM workstation is installed 
on the server computer. The workstations are only set up in the 
individual clients. If you want to use the server as an Allplan 
BCM workstation, run a client installation on the server after you 
have completed the server installation. 

7 Continue by installing the clients. 

Run the ClientSetup.exe file on the client. You will find the 
file in the ..\Daten\Nemetschek\Allbase\Daten\Client 
directory on the server. Then proceed as described in steps 7 to 9 
and 11 to 14 in the "Install Allplan BCM on a Standalone Work-
station (see "Installing Allplan BCM on a Standalone Workstation" 
on page 12)" section. 

8 Enter the program directory on the client in the Select path 
dialog box. 

9 Proceed from step 15 in the "Install Allplan BCM on a Standalone 
Workstation" section to complete the client installation. 

 

Tip: You can do this directly 
at each client without using 
the Allplan DVD. 
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Installing Demo Data 
On the Allplan DVD, you will find a selection of Allplan Quantities 
sample projects and other demo data (including standard text of 
various providers) for your convenience. Part of the demo data is 
installed automatically when you install Allplan Quantities for the 
first time. Using Allplan Quantities’s archive administration tool, you 
can quickly and easily import additional sample projects. 

When you update, the demo data is not installed automatically, 
ensuring that existing data is not overwritten. In this case, you can 
also simply use the archive administration to import the demo data. 

  

Note: Some sample projects use a predefined Allplan project. This 
project is also included in the Allplan DVD and can be found in the 
<dvd>\programs\Allplan BCM\Demodaten_Bau-
kosten\Allplandaten directory. Load this sample project by 
using Allplan’s archive administration (= Allmenu). 

 
 

Import Demo Data into Allplan Quantities 

To import demo data into Allplan Quantities 

1 Insert the Allplan DVD into the DVD drive. 

Note: After you have inserted the DVD, the Allplan start menu 
usually opens automatically. If this is the case, click the  

 Close button. 

2 Start Allplan Quantities. 

3 Click Archive on the Project Data menu. 

The Archive administration dialog box appears. 

4 Click Path. 

The Browse for folder dialog box opens. 

5 Select the DVD drive. 
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6 Set the path to a subfolder of the <dvd>\programs\Allplan 
BCM\Demodaten_Baukosten directory. Then click OK. 

The path is transferred straight to the Archive administration 
dialog box and the projects in the selected directory are 
displayed. 

7 Select the project(s) to be installed in the Archives list box (right 
pane in dialog box) and click the  Restore archive icon. 

8 Click Close in the Archive administration dialog box when the 
import is complete. 

You can then open these projects using the Project overview data 
sheet, for example. 
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Graphical Quantity Takeoff 
Operations Using Allplan 

Both when designing in 3D using Allplan and when editing files in 
Allplan Quantities, you generate data that is of relevance to the 
architectural design process. This data includes material and 
component definitions, specification descriptions consisting of items 
and quantities (length, area, number, volume, etc.). 

You can transfer this data, which needs to be made available to both 
Allplan and Allplan Quantities, from one system (in which the data 
originated) to the other system (where the data can be used for the 
subsequent design). This ensures that the data is only created once. 
Thus, possible sources of errors are excluded and the data volume is 
kept to a minimum. 

The quantities which are automatically created in Allplan when you 
design in 3D are particularly important for Allplan Quantities: as all 
the item quantities are transferred from Allplan to Allplan Quantities, 
is it not necessary to perform time-consuming quantity takeoff 
operations in Allplan Quantities. Furthermore, the costs of 
construction projects can be calculated quickly and efficiently based 
on master catalogs associated with prices. 

  

 
 

Functional Principle of Quantity Takeoff 
Operations Using Graphics 

First, the relevant specification descriptions are set up as item 
catalogs with a trade structure (= master file) in Allplan Quantities. 
In addition, a "code text" is assigned to these specification 
descriptions. Then, the items of this master file are used to create 
elements, which are combined in an element master. 
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The specification descriptions prepared in this manner are accessed 
when materials are defined in Allplan: in the process of designing 
components, materials are selected from the catalogs provided and 
assigned based on the code text. As Allplan automatically updates all 
the quantities of components, quantity takeoff schedules can be 
created quickly and easily once the design is complete. 

These schedules are transferred to Allplan Quantities and the code 
text is used to assign the quantities specified to the specification 
descriptions. As you go along, you can run analyses based on a wide 
range of different criteria and/or process these files in many different 
ways. 

Two columns of quantity takeoff schedules created in Allplan play a 
central role in graphical quantity takeoff operations: the Code text 
column (which can be considered equivalent to a material or item 
number) and the Quantity column. All the other columns like 
Component number, Room number, Room name and Component 
ID are primarily used to identify the individual quantity calculations 
in Allplan Quantities and only have a subordinate role as far as the 
actual data transfer is concerned. 

The significant advantage of this method is that VOB-compliant 
quantities are available immediately. In addition, fully automatic 
cost calculations can be performed when the items in the master 
catalogs are associated with the current prices. 

 
 

Catalog Types for Quantity Takeoff 
Operations Using Graphics 

A distinction is made between item catalogs and element catalogs. 

Specification descriptions in item catalogs are structured by trade. In 
element catalogs, the specification descriptions of different trades are 
automatically combined in "item packages" that fully describe a 
component. 

The master file is a special type of item catalog. It contains all the 
specification descriptions (= items) used for creating the individual 
elements in the element catalogs. 
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While designing in Allplan, you can assign individual items from an 
item catalog (= item method) or entire elements from an element 
catalog (= element method) to components and then transfer this 
data to Allplan Quantities where it can then be analyzed and 
evaluated in conjunction with the relevant file. 

  

Item catalogs 

The item catalogs are the master directories of all specification 
descriptions required for the implementation of construction projects 
and the associated tenders. 

Items in item catalogs are structured by trade. 

  

Master file 

The master file is the master directory of the specification 
descriptions required for creating elements in element catalogs. You 
can define your own specification descriptions. As an alternative, 
specification descriptions can be copied from item catalogs to the 
master file. 

Items in the master file are also structured by trade. 

Important! 
Using a master file is the best way to ensure that the quantities will 
be imported correctly. 

  

Elements 

An element consists of several items of different trades and describes 
a complete component. A possible element, for example, is an 
interior wall consisting of masonry, plaster, wallpaper, paint and 
baseboard. If you want, you can add further items (from the fields of 
electrical installations and sanitary facilities, for example) to this 
element. 

These items are integrated in the element using an "estimated" factor 
based on experience, for example. 
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You ideally create all the elements by using items from the master 
file. This way, you ensure that the item quantities specified in the 
quantity takeoff schedule can be correctly assigned to the relevant 
specification descriptions in the item catalog. The assignment is made 
based the code text and is only possible if the item catalog (= master 
file) used for creating the elements and the item catalog used as the 
basis for the import of quantities are exactly the same. 

  

Element master 

The element master is the project-independent master directory of all 
elements (= components) and serves as the basis for project-specific 
element schedules. 

It is a good idea to sort the element master by logical groups, 
facilitating quick access to the elements. Possible directories in the 
hierarchy would be exterior walls, interior walls, slabs etc., for 
example. 

  

Element schedules 

Element schedules are project-specific directories of elements 
(= components), which are set up based on the elements provided in 
the element master. Element schedules are used to limit the material 
offered for selection to only those elements (= materials) that are to 
be used in a project. 

Project-specific and trade-specific files are generated based on 
element schedules. This means that element schedules serve as the 
basis for item-specific quantity takeoff operations and the tender. In 
addition, element schedules can be used for cost calculations in 
compliance with DIN 276. 

Important! 
If you want to use element schedules to generate files later, the 
following requirements must be met: the elements must have been 
created based on items of the master file, which must include all the 
items and, in addition, the code text must match. 
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Requirements for Quantity Takeoff 
Operations Using Graphics 

System requirements 

Allplan and Allplan Quantities must be installed on the same 
computer or in a common network. 

In addition, the two systems must have full access to the directories 
described in the section entitled "System Configuration and 
Settings". 

  

Software requirements 

As Allplan and Allplan Quantities are continuously refined, new 
versions including new functions and improvements to existing 
features are available at regular intervals. 

To fully exploit the advantages provided by graphical quantity 
takeoff operations, you should always work with the latest versions 
of Allplan and Allplan Quantities . 

  

Design requirements 

Basic requirements concerning the design: 

• The building model must be created in 3D, so that the 
dimensions, quantities, cubic volume, etc. can be calculated. 

• All materials and attributes you want to include in analyses must 
be defined based on the catalogs provided by Allplan Quantities 
when you enter components or later. 
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System Configuration and 
Settings 

To ensure a seamless and smooth exchange of data between Allplan and 
Allplan Quantities, you need to make/check some settings just once. 

Otherwise, "online" access to data is not possible. In other words, 
you cannot access Allplan Quantities data while working in Allplan. 

  

Settings in Allplan Quantities 

You need to make two path settings in Allplan Quantities: 

• A path must be set to the data exchange directory in which Allplan 
stores the files with the results of quantity takeoff operations. 

• Another path must be set to the directory where Allplan’s default 
settings are saved. These defaults include component attributes 
(e.g. information on trades), which are important for setting up 
catalogs in Allplan Quantities (cf. section entitled "CAD 
Attributes for Items"). 

  

Settings in Allplan 

You also need to make/check two path settings in Allplan: 

• Before you begin designing in Allplan, make sure that the 
nem_ava catalog is selected for the components that you will 
need for designing. You can check this setting globally in the 
default settings or by calling the relevant function for each 
component. 

Note: The nem_ava catalog is usually preset by default for most 
components, but it still always a good idea to check just in case. 

• In addition, you need to set the path to the Allplan Quantities 
directory so that you can access the projects in this directory 
right from Allplan. 
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Set the Paths to Allplan in Allplan Quantities 

To set Allplan paths in Allplan Quantities 

1 Click Settings on the Extras menu. 

2 Open the Folders tab in the Settings dialog box. 

3 In the File type list box, scroll down to the end, select Allplan 
quantities and click the Edit button. 

4 The Browse for folder dialog box appears. Set the path to the 
Allplan exchange directory (usually ...\Program Files\ 
Nemetschek\Allplan\Usr\Local\i_o) and click OK. 

5 Using the same approach, define the path for the Allplan defaults. 

In the File type list box, select Allplan STD, click Edit and set the 
path (usually ...Daten\Nemetschek\Allplan\Std). 

6 Click OK. 
 

 

Check the "nem_ava" Catalog Assignment in 
Allplan 

To ensure the correct assignment of quantities and materials when 
performing quantity takeoff operations and transferring the results to 
Allplan Quantities, check that the nem_ava catalog is set for each 
component (surface, solid, component, baseboard, etc.) whose 
quantities you want to transfer to Allplan Quantities. 

  

To check the default setting of the catalog assignment 

1 Start Allplan. 

2 Click  Options on the Extras menu. 
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Or: 

Click  Options in the Standard toolbar. 

3 Click Architecture in the Options dialog box. 

4 Open the Settings tab in the Architecture Options dialog box. 

5 In the Catalogs, paths area, select the applicable component type 
in the list box on the right. Click Catalog assignment. 

6 In the left-hand column of the Attributes for quality selection 
dialog box, activate the attributes that are to be provided for the 
component. 

7 Make sure the nem_ava catalog is set for each activated attribute. 

If the catalog is not set for an attribute, click the right-hand 
column of that attribute and select nem_ava in the Catalog 
assignment dialog box. 

Note: You can change this setting any time by editing the 
properties of the individual component. 

8 Repeat steps 5 to 7 for all relevant components. 

  

To check the catalog assignment for individual 
component types during the design process 

 You have activated a tool for creating a component (e.g. the  
 Wall tool in the Walls, Openings, Components module). 

1 Open the Properties dialog box. 

2 Check the label on the button next to Catalog assignment (e.g. in 
the Parameters, Attributes tab for Wall properties and in the 
Material area for Slab properties). 

If the nem_ava catalog is not entered there, click the button and 
assign the nem_ava catalog to the individual material categories 
in the Attributes for quality selection dialog box. 

To do this, click the right table field in the relevant line and 
select nem_ava in the Catalog assignment dialog box. 

3 Click OK to confirm this setting for each material category. 
 



 

30 System Configuration and Settings Allplan BCM  

Set the Path to the Allplan Quantities 
Directory 

The path to the Allplan Quantities directory is entered the first time 
you open the material catalog in Allplan. This setting is saved and is 
thus available whenever you start Allplan. 

To set the path to the Allplan Quantities directory in 
Allplan 

1 In Allplan, activate a tool for creating components (e.g. the  
 Wall tool in the Walls, Openings, Components module). 

2 Open the  Properties dialog box. 

3 Open the Parameters, Attributes tab and click in the input field 
in the Material/Quality column. 

4 The first time the nem_ava catalog is activated, the Select the 
Catalog Data Path dialog box appears. 

Click Yes to specify the Allplan Quantities data path. 

5 Set the path to the Allplan Quantities directory (usually: 
...Daten\Nemetschek\Allbase\Daten) and click Select. 

The Catalog dialog box lists all the projects available in Allplan 
Quantities. 

6 Open the list box and select the project whose material definition 
you want to use. 

7 Select an element/item. 

8 Click OK to confirm your selection. 

9 Set the other parameters and design the component. 
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User Interface in Allplan 
Quantities 

The application window of Allplan Quantities basically consists of 
three areas: 

• the menu bar (see "Menu Bar in Allplan Quantities" on page 32) 
below the title bar of the window, 

• the toolbars below and 

• the space reserved for displaying data sheets. 
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Menu Bar in Allplan Quantities 
The menu bar in Allplan Quantities consists of the following menus: 

 

To activate a tool via the menu bar, all you need to do is click a menu. 
The menu clicked opens and you can select one of the tools presented.  

Note: A description of all the tools on the menus is provided in the 
reference section entitled "Menus and Tools" in the online help. 

 
 

Toolbars in Allplan Quantities 
You can use the buttons provided in the toolbars to activate the main 
tools without having to select a menu first. All you need to do is click 
the relevant icon. 

The toolbars in Allplan Quantities are divided into logical groups: The 
upper toolbar includes the most important, general tools that are not 
focused on any specific project. Consequently, this toolbar is named 
General functions toolbar. The lower toolbar – Project functions – 
provides project-specific functions. In the Text libraries toolbar, you 
can access text catalogs of various providers. For this, you need to 
install these catalogs first. 

 

Note: The sections entitled Buttons in the General functions toolbar, 
Buttons in the Project functions toolbar and Buttons in the Text 
libraries toolbar provide an overview of the functions you can select 
directly without opening a menu first. 

You can display and hide as well as dock and float the toolbars 
separately to suit your requirements. 
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Buttons in the "General Functions" Toolbar 
  

 

  

The button on the left in the General functions toolbar represents 
the following tool: 

Icon Function Use 

 Open project overview You can use this tool to execute the Project 
Overview command on the File menu, which 
opens the Project Overview data sheet. 

   

The five buttons in the next block of the General functions toolbar 
represent the following tools on the Data Record menu: 

Icon Function Use 

 New data record You can use this tool to execute the New 
command on the Data Record menu. 

 Cut data record You can use this tool to execute the Cut 
command on the Data Record menu. 

 Copy data record You can use this tool to execute the Copy 
command on the Data Record menu. 

 Paste data record You can use this tool to execute the Paste 
command on the Data Record menu. 

 Delete data record You can use this tool to execute the Delete 
command on the Data Record menu. 

   

The four buttons in the next block of the General functions toolbar 
help you select data records: 

Icon Function Use 

 Mark current line You can use this tool to execute the Mark Line 
command on the Data Record menu. 
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Icon Function Use 

 Mark entire hierarchy You can use this tool to execute the Mark 
Hierarchy command on the Data Record menu. 

 Cancel current line 
marker 

You can use this tool to execute the Cancel 
Marking command on the Data Record menu. 

 Cancel hierarchy 
marker 

You can use this tool to execute the Cancel 
Hierarchical Marking command on the Data 
Record menu. 

   

The six buttons in the adjacent block of the General functions 
toolbar are provided for quickly moving the insertion marker in a 
vertical direction within a data sheet: 

Icon Function Use 

 Top of data sheet You can use this tool to move the insertion 
marker to the top (= first line) of the data sheet, 
which defines the section displayed (equivalent 
to the  Goto Project Start tool on the Data 
Record menu). 

 Hierarchy step upwards You can use this tool to move the insertion 
marker up to the next data record on the same 
level in the hierarchy (equivalent to the 
Hierarchy Step Upwards tool on the Data 
Record menu). 

 Up You can use this tool to move the insertion 
marker up a line (equivalent to the Line Step 
Upwards tool on the Data Record menu). 

 Down You can use this tool to move the insertion 
marker down a line (equivalent to the Line Step 
Downwards tool on the Data Record menu). 

 Hierarchy step 
downwards 

You can use this tool to move the insertion 
marker down to the next data record on the 
same level in the hierarchy (equivalent to the 
Hierarchy Step Downwards tool on the Data 
Record menu). 

 Bottom of data sheet You can use this tool to move the insertion 
marker to the end (= last line) of the data sheet, 
which defines the section displayed (equivalent 
to the  Go to Project End tool on the Data 
Record menu). 
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The two buttons on the far right in the General functions toolbar are 
frequently used tools: 

Icon Function Use 

 Print You can use this tool to execute the Print 
command on the File menu. 

 Help You can use this tool to activate the context-
sensitive online help; i.e. help on the tool, data 
sheet etc. that is currently active is displayed. 

   

 
 

Buttons in the "Project Functions" Toolbar 
  

 

  

The Project functions toolbar includes buttons for the most 
important tools that you need to edit projects. This way, access to 
the most frequently used tools is provided without requiring you to 
select a menu first. 

Icon Function Use 

 (left) Select scheme You can use this button to open the Select 
scheme list box, which lets you set the data 
sheets’ contents and appearance. 

 (right) Data sheet 
(= processing 
phase) 

You can use this button to display the data sheet 
for the current project phase. 

 Open project You can use this tool to execute the Open 
command on the File menu. 

 Undo You can use this tool to execute the Undo 
command on the Data Record menu. 

 Repeat You can use this tool to execute the Repeat 
command on the Data Record menu. 
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Icon Function Use 

 Filter current hierarchy You can use this tool to show only the data 
records of the current level in the hierarchy. 

 Hide current hierarchy You can use this tool to execute the Hide 
Current Hierarchy command on the Data 
Record menu. 

 Display current 
hierarchy 

You can use this tool to execute the Display 
Current Hierarchy command on the Data 
Record menu. 

 Display all hierarchy 
levels 

You can use this tool to execute the Display All 
Hierarchy Levels command on the Data Record 
menu. 

 Calculate everything You can use this tool to execute the Calculate 
Everything New command on the Calculation 
menu. 

   

 
 

Buttons in the "Text Libraries" Toolbar 
  

 

  

The Text libraries toolbar provides buttons you can use to access the 
most important text libraries associated with Allplan Quantities. 
Requirement: the relevant library must be installed. 

Icon Function Use 

 Architekten-Service You can use this tool to execute the 
Architekten-Service command provided in the 
Text libraries tool on the Tools menu. 

 ausschreiben.de You can use this tool to execute the 
ausschreiben.de command provided in the Text 
libraries tool on the Tools menu. 
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Icon Function Use 

 HeinzeBauOffice You can use this tool to execute the 
HeinzeBauOffice command provided in the Text 
libraries tool on the Tools menu. 

 DBD-Dynamische 
Kostenelemente 

You can use this tool to execute the DBD-
Dynamische Kostenelemente command 
provided in the Text libraries tool on the Tools 
menu. 

 DBD-LVexpress You can use this tool to execute the DBD-
LVexpress command provided in the Text 
libraries tool on the Tools menu. 

 Standard service 
catalog for building 

You can use this tool to execute the STLB-Bau 
command provided in the Text libraries tool on 
the Tools menu. 

 GreenBASE - Plant 
Disposition 

You can use this tool to execute the GreenBASE 
- Plant Disposition command provided in the 
Text libraries tool on the Tools menu. 

 sirAdos building data You can use this tool to execute the sirAdos 
building data command provided in the Text 
libraries tool on the Tools menu. 

 Standard service 
catalog 

You can use this tool to execute the StLB 
command provided in the Text libraries tool on 
the Tools menu. 
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Basic Introduction 
This chapter deals with the basics that are essential for your under-
standing of Allplan Quantities. 

Here, you can find general information about data sheets as well as 
specific information on the purpose, structure, and setup of the 
individual data sheet types. 

In addition, this chapter provides detailed information on memo 
fields, object fields, and processing templates. It also shows you how 
you can use the user-definable settings to customize Allplan 
Quantities to your needs. 

Furthermore, this chapter covers how to generate printouts, i.e. how 
to print overviews, files, cost calculations, quantity calculations, etc. 

  

ATTENTION! 
Data backup is generally one of the critical issues in the IT industry. 
For this reason, backing up data and archiving projects are covered 
in a separate section. There, you will learn how to archive, back up, 
and restore projects and how to back up your individual column 
settings, column definitions and reports, and how to restore them. 

  

 
 

About Data Sheets 
Data sheets play a central role in Allplan Quantities. Opening a data 
sheet establishes a link between the data sheet and the relevant 
database. The relevant data is read from the database into the 
selected data sheet where it is entered in the individual lines and 
columns, as in a spreadsheet. This link is retained until you close the 
data sheet. 
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There are three types of data sheets: 

• Project-independent data sheets 

• Data sheets for managing master data 

• Project-specific data sheets 

  

Project-independent data sheets 

All the projects and master data are managed in the Project 
overview data sheet (see ""Project Overview" Data Sheet" on page 
41) where you can create new projects, delete projects you no longer 
need, save and load projects. 

In the Address overview data sheet (see ""Address Overview" Data 
Sheet" on page 42), you can access and organize addresses. In 
addition to the various options provided for sorting, finding and 
filtering addresses, you can also print out the addresses you have 
archived. 

Objects (e.g. images and sketches) are managed centrally in the 
Image overview data sheet (see ""Image Overview" Data Sheet" on 
page 44). For example, you can copy objects to this data sheet using 
the Windows Clipboard or add OLE objects to the image database. 
The objects archived in the image database can then be copied to the 
Windows Clipboard and pasted into the object windows of project-
specific data sheets. This way, objects can be integrated into projects 
or used as company logos in printouts, for example. 

The CAD XPad (see ""CAD XPad" Data Sheet" on page 45) data sheet 
displays the CAD data currently imported. In addition, you select the 
items to be integrated in a project in this data sheet. 

  

Data sheets for managing master data 

Allplan Quantities provides the Master and Element master data 
sheets for managing master data. 

The difference between master text and element catalogs is that 
master text is usually structured based on the individual items in a 
file (i.e. sorted by title). In element catalogs, on the other hand, items 
are structured on a component-oriented basis. 

Tip: A general description of 
how to work with data sheets 
is provided in the section 
entitled "Using Data Sheets". 
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Note: As the Master and Element master data sheets have a data 
structure similar to project-specific data sheets and work in the same 
way, they are not explained separately. Where differences exist, they 
will be pointed out in the relevant description. 

  

Project-specific data sheets 

Projects are edited using the project-specific data sheets. Allplan 
Quantities provides data sheets for all the phases of a project; this 
means that you can use the data sheet best suited to the task at 
hand. Only the data that is relevant to the current phase is entered in 
the data sheet associated with the phase in question. 

In a project, initial cost estimates are made right from the outset. 
Using the options provided by Allplan Quantities, you can quickly 
get an overview of the cost of the building and/or the individual 
components used. All you need to do is copy the elements you want 
to include from the Element master data sheet to the project-specific 
Element schedule data sheet. Then you simply complete the 
quantities - that’s all! Element schedules can also be analyzed and 
evaluated based on DIN 276-compliant cost groups by using the 
relevant reports. 

In the Calculation data sheet, you can create files for a project and 
perform quantity and cost calculations. 

  

 
 

"Project Overview" Data Sheet 

In Allplan Quantities, the term "project" encompasses master text, 
element catalogs, element and room schedules as well as the actual 
files. The Project overview data sheet (how to open...) provides up-
to-date information on the projects (in the currently set data 
directory) and their processing status. 

You can customize the contents and layout of the Project overview 
data sheet to suit your needs. For example, a Project overview data 
sheet that has just been opened might look like this: 
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The projects displayed in the Project overview data sheet can be 
sorted alphabetically by column and filtered according to different 
criteria. This way, you keep a good overview, even with a large 
number of projects. Moreover, for each project overview output, only 
the data lines displayed in the Project overview data sheet will be 
taken into account. Thus, all sorting and filter criteria you have 
specified will also be included in printouts. 

An overview of the projects included in the project management can 
be displayed on screen or sent to a printer. Here again, the output 
will be limited to the data lines displayed in the Project overview 
data sheet. This means that all the criteria you have defined using 
the Organize and filter tool will be taken into account. 

Projects you no longer need can be deleted from the current project 
management data directory and from the archive. 

Note: For descriptions of how to do all this, see the "Editing projects" 
section. The "Columns in the Project overview data sheet" section 
provides information on the columns of this data sheet and their 
contents. 
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"Address Overview" Data Sheet 

The contact data of your clients, design partners and potential 
contractors, which you need for your daily work, can be managed in 
the central Allplan Quantities address database. This means that you 
do not have to re-enter the addresses each time again, but you can 
retrieve them easily from the address database when working within 
any program module. 

The Address overview data sheet (how to open...) provides an 
overview of all addresses archived in the central database (e.g. 
addresses of clients, authorities, employees etc.). 

You can customize the contents and layout of the Address overview 
data sheet to suit your needs. For example, an Address overview 
data sheet that has just been opened might look like this: 

  

 

  

The addresses displayed in the Address overview data sheet can be 
sorted alphabetically by column and filtered according to different 
criteria. This way, you keep a good overview, even with a large 
number of archived addresses. Moreover, for each address overview 
output, only the data lines displayed in the Address overview data 
sheet will be taken into account. Thus, all sorting and filter criteria 
you have specified will also be included in printouts. 

An overview of the addresses archived in the address database can 
be displayed on screen or sent to a printer. Here again, the output 
will be limited to the data lines displayed in the Address overview 
data sheet. This means that all the criteria you have defined using 
the Organize and filter tool will be taken into account. 
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Addresses you no longer need or that have become obsolete can be 
deleted from the address database including all associated address data. 

Note: For descriptions of how to do all this, see the "Editing 
addresses" section. The "Columns in the Address overview data 
sheet" section provides information on the columns of this data sheet 
and their contents. 

 
 

"Image Overview" Data Sheet 

In Allplan Quantities, you can enhance your files by adding images 
and sketches (= "objects"). The image database offers the option to 
centrally archive all the objects available for your projects. 
Consequently, the objects saved in the image database can be 
accessed from within any program module, either while editing your 
projects or by retrieving them from the address database. 

The Image overview data sheet (how to open...) provides a list of all 
the objects archived in the image database. 

You can customize the contents and layout of the Image overview 
data sheet to suit your needs. For example, an Image overview data 
sheet that has just been opened might look like this: 

 

The objects displayed in the Image overview data sheet can be 
sorted alphabetically by column and filtered according to different 
criteria. This way, you keep a better overview, even with a large 
number of archived objects. Moreover, for each object overview 
output, only the data lines displayed in the Image overview data 
sheet will be taken into account. Thus, all sorting and filter criteria 
you have specified will also be included in printouts. 
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An overview of the objects archived in the image database including 
the associated object information can be displayed on screen or sent 
to a printer. Here again, the output will be limited to the data lines 
displayed in the Image overview data sheet. This means that all the 
criteria you have defined using the Organize and filter tool will be 
taken into account. 

Note: For descriptions of how to do all this, see the "Editing images 
and sketches" section. The "Columns in the Image overview data 
sheet" section provides information on the columns of this data sheet 
and their contents. 

 

"CAD XPad" Data Sheet 

The CAD XPad data sheet (how to open...) represents the interface 
between project handling with Allplan Quantities and other 
applications such as the Allplan CAD system. The CAD XPad data 
sheet should be considered as a temporary database for CAD data to 
be imported (e.g. results from quantity calculations). In addition, this 
tool provides a convenient way to quickly make entries which can 
later be used to generate element schedules or files. 

Before integrating Allplan data into an element schedule or a file, 
you can import this data into the CAD XPad data sheet first. Once 
the import process is complete, you can check its results by 
displaying the contents of the CAD XPad data sheet. The CAD XPad 
further enables you to filter the imported data records for the specific 
components you want to transfer to your file structure. 

ATTENTION! 
Bear in mind that the entries in the CAD XPad data sheet are not 
saved permanently. They will rather be overwritten whenever you 
import new data. To preserve the current contents of the CAD XPad 
data sheet, you need to integrate the data into a file structure. 

You can customize the contents and layout of the CAD XPad data 
sheet to suit your needs. For example, a CAD XPad data sheet that 
has just been opened might look like this: 
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The components contained in the CAD XPad data sheet after 
importing the CAD data can be sorted alphabetically by column and 
filtered according to different criteria. As only the components that 
are displayed when you access the CAD XPad -> Element Schedule 
or CAD XPad -> Project tool are transferred to an element schedule 
or file, the filter functions play a decisive role here. 

Note: For descriptions of how to do all this, see the "Editing CAD data" 
section. The "Columns in the CAD XPad data sheet" section provides 
information on the columns of this data sheet and their contents. 

 

Project-Specific Data Sheets 

To edit a project, you need to open it in a project-specific data sheet. 
To facilitate showing and hiding of parts of the hierarchy, a "navigator", 
which is similar to that in Windows Explorer, is displayed in the 
Type column of these data sheets (not available in the CLASSIC 
scheme). This navigator has much in common with the Windows 
Explorer: You can open and close hierarchies simply by clicking on 
the corresponding  or  icon. Or, for example, you can reposition 
or copy items to other data sheets by dragging and dropping them. 

But there are some differences to the navigator in the Windows 
Explorer: in the Windows Explorer, there is no fixed order for the 
file display. After each update, the files will be reordered, e.g. 
alphabetically. In Allplan Quantities however, the data records are 
always arranged in the order specified by you. For this reason, when 
dragging and dropping an item, do not drag it to the title where you 
want to insert it, but exactly to the line above which you want to 
insert the item. 
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The contents and layout of an open data sheet depend on your personal 
settings and of course on your project data. For example, a project-
specific data sheet that has just been opened might look like this: 

  

 

  

While you edit a project using a project-specific data sheet, Allplan 
Quantities buffers your edits line by line. This means that, each time 
you enter or modify data, these will be stored temporarily in the RAM 
of your computer. The changes are not written to the database until 
you exit the line to edit another line. When you are working in a net-
work, this mode allows multi-user access; in other words, the project 
can be opened and edited on several computers simultaneously. 

Note: For a general description of how to set up and use project-
specific data sheets, see the section entitled "Using Data Sheets". The 
"Columns in project-specific data sheets" section provides further 
information on the columns of these data sheets and their contents. 
More detailed information on creating and editing data records is 
provided in the "Basics of Working with Data Records" section. 
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Calculation Elements in Data Sheets 
As you work in Allplan Quantities, you will find that the Master and 
Element Master data sheets as well as the project-specific data 
sheets contain similar hierarchic structures, which consist of data 
lines opening levels in the hierarchy and data lines closing levels in 
the hierarchy. 

Data lines opening levels in the hierarchy never exist on their own. 
Rather, they are always complemented by the associated data lines 
closing levels in the hierarchy. When, for example, you create a new 
project and open the data sheet, the ‘Project’ entry has already been 
created in the first data line and the ‘Cost’ entry in the second data 
line. This means that the ‘Cost’ data line closes the ‘Project’ level. 

  

 

  

All the data you enter now is integrated in the hierarchy defined and 
delimited by "Project - Cost". Each time you create a new data record 
in the hierarchy, you will find that the associated data line closing 
this level in the hierarchy - ‘Total’ or ‘Cost’ - is created 
automatically. 

These additional data lines closing the hierarchy are always 
appended to the end of a level in the hierarchy. When, for example, 
you place the insertion marker in a sum line and create a new item, 
this item is inserted in this line and consequently, the sum line 
automatically moves down a line. 
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As you can see in the illustration, the ‘Project’, ‘Folder’, ‘File’ and 
‘Title’ data lines open a level in the hierarchy. 

The ‘Total/End’ and ‘Cost’ data lines close a level in the hierarchy. 

The data lines of the lowest level in the hierarchy - ‘Item’ and 
‘Comment’ – cannot open a new level in the hierarchy. 
Consequently, there are no associated data lines closing this level. 

 
 

"Project - Cost" Calculation Element 

The "Project - Cost" combination opens the hierarchy in each 
calculation data sheet. All the other levels in the hierarchy (e.g. 
folders or files) are delimited by this combination, which exists just 
once in each calculation data sheet. 

  

 

  

The data records that are directly subordinate to the project level in 
the hierarchy are totalized both in the project line and in the cost 
line. 
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"Folder - Cost" Calculation Element 

The "Folder - Cost" level, which can be inserted between the project 
level and the file level in the hierarchy, allows you to refine the 
hierarchic structure of projects (e.g. taking into account various 
construction stages, sections or components). 

  

 
  

The elements that are directly subordinate to the ‘Folder’ level in the 
hierarchy are totalized in the ‘Folder’ line and the associated cost 
line. 

 
 

"File - Total/End" Calculation Element 

The "File – Total/End" level cannot include any further files. A folder 
or project, on the other hand, can contain several files. Files are 
always subordinate to the project or folder line. 

  

 
  

The elements that are directly subordinate to the ‘File’ level in the 
hierarchy are totalized in the ‘File’ line and the associated sum line. 
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"Title - Total/End" Calculation Element 

Titles refine a file’s structure. The "Title – Total/End" level can 
include any number of subordinate titles (e.g. subtitles). 

  

 
  

The elements that are directly subordinate to the relevant title in the 
hierarchy are totalized in the ‘Title‘ line and the associated sum line. 

 
 

"Item" Calculation Element 

Items are data records of the lowest level in the hierarchy. You 
cannot create any items that are subordinate to items. Consequently, 
items consist of one line only (an associated sum line does not 
exist!). 
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"Comment" Calculation Element 

As with items, comments are data records of the lowest level in the 
hierarchy. You cannot create any comments that are subordinate to 
comments. 

 

 
 

"Element - Total/End" Calculation Element 

The "Element – Total/End" level in the Element Schedule and 
Element Master data sheets can be considered equivalent to files and 
titles in other data sheets. 

 

It is often necessary to create mixed hierarchic structures in the 
Element Schedule and Element Master data sheets (for example, 
"Story" element, "Room" element including the "Chair" item and an 
additional element - "Computer"; this "Computer" element in turn 
contains the items "Processor", "Screen" and "Keyboard"). 

The elements that are directly subordinate to the relevant title in the 
hierarchy are totalized in the ‘Title‘ line and the associated sum line. 
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Memo Fields and Text Windows 
Memo fields cannot be filled in directly in data sheets; in other 
words, you cannot make any entries in the columns of memo fields. 
They are rather used as placeholders for text. Therefore, these data 
fields are simply characterized by the entry ´Memo´ or ´memo´ in 
data sheets. 

The difference in spelling – ´Memo´ or ´memo´ – indicates whether 
or not text has already been assigned to a memo field: ´Memo´ fields 
include text while ´memo´ fields are still empty. 

When you open a memo field, the hidden text associated with this 
field is displayed in a separate window (also referred to as a text 
window). You can enter any text in a text window. This text can 
then be included in printouts of projects or overviews if an 
appropriate report has been selected. 

For example, memo fields are included in the Construction project, 
Client and Note columns of the Project overview data sheet as well 
as in the Long text column of project-specific data sheets. 

When you activate the search tool in an open text window, this tool 
offers an advanced option: you can search AND replace any 
alphanumeric character string. Starting at the current position of the 
insertion marker, the search tool scans text from top to bottom. The 
first occurrence of the specified term is selected. The selected 
characters can be replaced automatically with a different term, if 
specified. 

You can use all Windows fonts installed on your computer for the 
on-screen display of text in text windows. In addition, you can 
choose from standard, italic, bold and bold/italic styles. The font 
sizes that are available to you depend on the fonts you have 
installed. 

Note: You can change the appearance of fonts for the on-screen 
display of text windows using the Data sheets tool on the Extras 
menu.  

Important! 
To modify the appearance of fonts for printouts, use the report 
designer. 
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Object Fields and Object Windows 
Object fields are data fields which only contain an ´Obj´ or ´obj´ 
entry in data sheets. When you double-click on an object field, the 
hidden object associated with this field is displayed in a separate 
window (also referred to as an object window). 

The difference in spelling – ´Obj´ or ´obj´ – indicates whether or not 
an object has already been assigned to the respective object field: 
´Obj´ fields include an object while ´obj´ fields are still empty. 

Object fields are arranged in the Image column of data sheets. 

Note: If the Image column is not displayed in your data sheet, close 
the data sheet and reopen it using the ADMINISTRATOR scheme. If 
you are using a user-defined scheme, add this column to the scheme 
(cf. "Add Normal Columns to Data Sheets"). 

  

 
 

Shortcut Menu 
In addition to the menus (see "Menu Bar in Allplan Quantities" on 
page 32), toolbars and shortcuts, Allplan Quantities also provides 
shortcut menus as an alternative way to access tools and execute 
commands. 

Shortcut menus have the advantage that they can be accessed 
directly and offer a context-sensitive set of tools and commands. 
This means that the available choices always depend on the state or 
context from which you open the shortcut menu. To give you an 
example, if you are setting up a file and the insertion marker is in 
the Short text column, you will get a different shortcut menu than if 
you are calculating quantities and the insertion marker is in a 
column of the quantity block. Not all input fields have a shortcut 
menu, though. When right-clicked, some open a dialog box instead 
(e.g. the Dimension input help dialog box opens from the Dim 
column). In other input boxes, no functionality is assigned to the 
right mouse button (e.g. in memo fields). 
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Note: The tools and commands provided on the shortcut menus are 
the same as those you can access or select through the menus, 
shortcuts or toolbars. 

  

Here you can see the shortcut menus for the Short text column (left) 
and the Quantity column (right), both opened from the Calculation 
data sheet: 

 

  

 
 

Processing Templates 
Allplan Quantities provides a number of processing templates for 
editing master text and files. As with data sheets, processing 
templates for all the phases of a project are available; this means 
that you can select the processing template that best suits your 
current task. 

Each processing template already contains all data from a data 
record that is relevant to a specific phase. Therefore, processing 
templates provide an alternative method for displaying data sheets, 
allowing you to focus on the data of a specific data record (e.g. item) 
for a certain processing phase. 
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When you open a processing template, the values and texts from the 
data record in which the insertion marker is currently placed are 
entered in the processing template and can then be edited. 

  

 
  

By using the six buttons in the lower left corner of each processing 
template, you can retrieve the data of a different data record for 
display in the processing template without having to close and re-
open it for the new data record: 

Icon Function 

 Display the data of the first data record in the data sheet. 

 Display the data of the previous data record on same level in the hierarchy. 

 Display the data of the previous line. 

 Display the data of the next line. 

 Display the data of the next data record on same level in the hierarchy. 

 Display the data of the last data record in the data sheet. 
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Important! 
When you display data of a different data record by using buttons or 
by closing a processing template, the data of the current data record 
in the data sheet will be updated. So before you display data of a 
different data record or close a processing template, check whether 
you really want to keep the changes you have made to the current 
data record and apply them to the data sheet. 

If you do not want to apply the changes you have made in the 
processing template, discard them before you close the processing 
template or display a different data record. 

  

Macros 
Allplan Quantities provides a number of macros that facilitate more 
complex tasks. As with data sheets, macros are available for all the 
phases of a project; this means that you can use the macro that best 
suits the current task. 

Not all macros are helpful or required in all phases/data sheets. For 
this reason, macros are usually associated with specific phases/data 
sheets, i.e. macros that are, e.g., available in the Calculation data 
sheet are not automatically available in all other phases. 

However, it is possible to copy macros from one phase/data sheet to 
another phase/data sheet. However, please note the following: 

Important! 
Please note that macros that have been copied to a different phase 
might need to be adjusted to that phase. The program does not 
automatically analyze whether it makes sense to copy the macro or 
whether its contents need to be adjusted! 

  

Wizards 
Wizards guide you comfortably through unusual tasks. 

Just like macros, not all wizards are helpful or required in all 
phases/data sheets. For this reason, some of the wizards are 



 

58 Basic Introduction Allplan BCM  

associated with specific phases/data sheets, i.e. a wizard that is 
available, e.g., in the Calculation data sheet is not automatically 
available in all other phases. 

  

The following wizards are available: 

Wizard Function Requirements 

Print user settings Prints the user settings of the 
current user or of all Allplan 
Quantities users set up in the 
Allplan Quantities user manager. 

All data sheets and dialog boxes are 
closed. 

Copy reports Copies reports across phases. Available in all phases/data sheets. 

Integrate DIN-Classification Copies the entire DIN 276 classi-
fication to the new project (cf. 
"Copying the DIN 276 Cost 
Classification in Its Entirety"). 

The DIN 276 Estimation or DIN 276 
Calculation data sheet is active and 
the DIN 276 CLASSIFICATION 
project has been installed. 

Create data for MS Project Copies the data relevant for 
scheduling with MS Project to the 
Clipboard from where they can be 
inserted into MS Project (cf. 
"Scheduling"). 

The Calculation data sheet is active. 

Allocate variables of elements Creates a table where you can easily 
assign values to all variables 
available in an element schedule (cf. 
"Calculating Element Quantities" 
and "Calculating Quantities by 
Using Variables"). 

The Element schedule data sheet is 
active. 

Copy macros Copies macros across phases (cf. 
"Copying Macros"). 

Available in all phases/data sheets. 

Diversify display of schemes Temporarily changes the 
representation (grid lines and font) 
of the current data sheet. 

Any data sheet is open in a scheme 
without tabs. 

Integrate Ö-Norm B 1801 
structure 

Copies the entire classification (or 
"structure") in compliance with Ö-
Norm B 1801 to the current project. 

The DIN 276 Estimation or DIN 276 
Calculation data sheet is active and 
the Ö-Norm B 1801 structure 
project has been installed. 
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User-Definable Default and Data Sheet 
Settings 

User-definable default settings 

In Allplan Quantities, you can select various defaults that are saved 
permanently. 

For example you can specify 

• in which paths and directories the data is stored and saved, 

• whether and when prices, quantities and other entries in data 
sheets are calculated and/or updated, 

• whether a selection dialog box is displayed when data records are 
copied or deleted, 

• whether projects are optimized automatically when they are 
opened, 

• whether you are running Allplan Quantities in a network. 

These default settings can be defined in the Adjustments dialog box. 

  

User-definable data sheet settings and column definitions 

Besides the default settings, you can also define various data sheet 
settings (font, columns, column sequence, column headers etc.) for 
the data sheets. You can save the settings in a custom scheme, so 
that you can open the data sheets with the settings best suited for 
your requirements right away. 

Besides these custom data sheet settings, each data sheet provides 
several free columns, which you can use as required. For example, 
you can create columns for a separate key number or a second set of 
long text (comments on items or the translation of long text into a 
different language). 

The settings for the data sheets are defined in the Scheme dialog 
box. 
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Catalogs for Quantity 
Takeoff Operations Using 
Graphics 

Catalogs provide the common basis for graphical quantity takeoff 
operations using Allplan and Allplan Quantities. These catalogs, 
which contain specification descriptions as item data, are created 
and maintained using Allplan Quantities. As you work with Allplan, 
you can assign individual items (= item method) or entire item 
packages (= element method) from catalogs to quantities generated. 

There are different ways of exchanging data between Allplan Quantities 
and Allplan. The following descriptions explain the philosophy behind 
graphical quantity takeoff operations. Please note that the format of 
this manual puts a limit on the number of options we can present. 
With the wide variety of possibilities offered, you can create even 
very complex catalogs. 

When defining materials in Allplan, you can access all the projects 
available in the Allplan Quantities directory you have set. The way 
in which materials are defined varies depending on the catalog type 
(item catalogs, master file or element catalogs) selected in Allplan 
Quantities (cf. section entitled "Defining Materials in Allplan"). 
Please note the special features of the individual catalogs. 

Important! 
You can specify the catalog from which the elements or items are to 
be taken. This allows you to select the catalog that best suits your 
needs. 

Make sure that you are dealing with the correct catalog when 
importing CAD data into Allplan Quantities later. Otherwise, the data 
may not be processed correctly. 
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It is not advisable to mix catalogs. Before you begin, decide on the 
specification descriptions you require in Allplan and set up an 
appropriate "CAD catalog" in Allplan Quantities. 

  

Some notes on the individual catalogs: 

a) Item catalogs 
When you select materials in Allplan, item catalogs are marked with 
an (S) after the project name (exception: master file). 

CAD data generated based directly on item catalogs can be imported 
into Allplan Quantities by using the "CAD XPad -> Project" tool 
when you import the data for the first time. When updating an 
existing file, use the "CAD XUpdate" tool. 

It is essential to make sure that you have specified all the catalogs 
needed for the import; otherwise, the quantities may not be assigned 
correctly. The best approach therefore is to create a special, CAD-
specific master file based on the items of the item catalogs. 

b) Master file 
As a master file is maintained like a "normal" project file, it is 
marked with a (P) after the project name when you select materials 
in Allplan. 

You can also use the "CAD XUpdate" tool to import CAD data into a 
master file (or a copy of a master file). You can then quickly and 
easily delete items that are not used or associated with quantities. 

c) Element catalogs 
When you select materials in Allplan, element catalogs are marked 
with an (E) (= project-independent element catalog) or with a (R) (= 
project-specific schedule) after the project name. 

Here, too, you can use the "CAD XUpdate" tool provided by Allplan 
Quantities to import CAD data generated based on element catalogs. 
This data can be imported into a copy of the master file, for 
example. 
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Setup and Structure of CAD Catalogs 
Why are special CAD catalogs useful? 

When defining materials in Allplan, you can access all the projects 
available in Allplan Quantities in order to select specification 
descriptions from different catalogs. In spite of significant 
advantages, this has several disadvantages, however: 

• It can happen that you need to open several catalogs and perform 
tedious searches until you find the item you want to use. 

• When importing CAD data into Allplan Quantities, you need to 
specify the catalogs from which you have taken items 
(disadvantage: you must remember the catalogs you have used). 
As an alternative, you can also specify all existing catalogs 
(disadvantage: doing so can increase the time required for 
import). 

To avoid these disadvantages, you can use special CAD catalogs 
customized to meet the requirements imposed by design tasks. These 
catalogs, which are created based on existing item catalogs, have the 
following advantages: 

• CAD catalogs only contain items and/or elements that are 
relevant to the design, providing quicker access to 
items/elements. 

• When importing CAD data, you only need to specify a single 
catalog containing all necessary items. 

• Items can be set up to suit the needs of designers: for example, 
the specification descriptions of plaster and paint can be used to 
generate a single element named "Wall with plaster and paint". 
Although these specification descriptions belong to different 
trades in the item catalogs, you do not have to perform time-
consuming searches. 

  

Type and structure of a CAD catalog 

It is worth spending time carefully planning a CAD catalog's 
structure before even drawing the first line in Allplan: define the 
materials you want to use or decide on the rooms’ equipment 
properties, for example. 
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Combine the specification descriptions you require for these 
materials and equipment properties in a separate CAD item catalog 
(= master file). You can even use this catalog to define materials in 
Allplan by assigning individual items to components (= item 
method). 

In contrast to pure CAD item catalogs, however, CAD element 
catalogs have significant advantages: 

• You can combine several items in elements when defining 
materials using Allplan. You can then transfer these "item 
packages" in their entirety by making a single assignment in the 
CAD system (= element method). 

• The same applies for the "Room" tool in Allplan. 

• Using elements, you can create hierarchies of any structure. This 
allows you to generate well-designed CAD catalogs. 

• Element catalogs can contain several instances of an item 
although duplicate data storage is avoided. For example, the 
"Plaster" item can be assigned to both exterior and interior wall 
elements. 

The CAD catalog you set up should thus be customized to meet the 
requirements of the design tasks and define elements by combining 
items from the item catalog. 

Important! 
The item catalog (= master file) serves as the basis for the element 
catalog. Prior to creating the item catalog, spend some time thinking 
about how best to structure it and, if possible, you should not make 
changes afterwards.  

Element catalogs only contain copies of the actual items. When CAD 
data is imported into Allplan Quantities, however, the items are 
taken form the item catalog. It is therefore important that you update 
and maintain the items in the item catalog. Any changes you make 
to items in element catalogs are not recognized. 

Furthermore, you can only copy the current prices from the item 
catalog to an element catalog when the elements in the element 
catalog you want to use have been created based on items of the 
item catalog. 
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Creating a CAD item catalog (master file) based on an element 
catalog 

Allplan Quantities offers the option to automatically generate trade-
specific files based on element catalogs (element masters or element 
schedules). 

If you have created a CAD element catalog based on items from 
different master catalogs, you can use this element catalog to 
generate a CAD item catalog, which is necessary for a correct import 
of quantities. 

  

 
 

Code Text for Items and Elements 
Code text is a freely definable combination of characters that needs 
to be defined for each item/element. It is essential that a unique code 
text be assigned to each item/element. You can manage code text in 
Allplan Quantities using the Code text column. 

Whereas the item number of any item may change in each file, code 
text always stays the same. This means that code text serves as the 
unique identifier for items in master catalogs, files and element 
schedules. 

Due to its properties, code text is used as an "assignment key". In 
other words, materials, quantities and specification descriptions are 
assigned based on code text: first in Allplan Quantities by defining 
"Item/Element -> Code text", next in Allplan by assigning "Material 
= Code text" and then again in Allplan Quantities by specifying 
"Code text/Quantity -> Specification description/Quantity". 

  

Important! 
Code text of items must be entered in the item catalog. You should 
ensure that each item includes a unique code text. Unique means 
that each combination of characters exists just once. You should not 
modify code text later. 
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Note: Code text of an item can consist of a maximum of 16 
characters and that of an element of 15 characters maximum. Code 
text may include letters, numbers and "-./_". 

  

ATTENTION! 
However, it must not contain blanks! 

  

For example, you can create code text based on a number key or 
character sequence: 

Example 1: 

Code text stands for ... 

012020110 the "Vertically perforated brick 36.5" item in its 
entirety 

012020110 trade 012 "Masonry" 

012020110 the second subtitle "Exterior walls" 

012020110 the consecutive item number; increments of ten 
are useful as you can add items later without 
having to adjust numbering. 

  

Example 2: 

Code text stands for ... 

012VPB365 the "Vertically perforated brick 36.5" item 

The code text indicates the contents of the item. 

  

Example of a code text key in an item catalog: 
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CAD Attributes for Items 
Items in CAD catalogs can be associated with additional attributes 
which have already been defined in Allplan and which are necessary 
for correct quantity takeoff operations using Allplan: 

• You can use the Trade option to define regulations based on 
which openings, niches, reveals etc. are analyzed and evaluated. 
You can specify different regulations for each trade. 

The trade that is to be applied to an item for evaluation and 
analysis is matched to the trade list in Allplan by transferring the 
trade and trade number from Allplan. 

• In the element catalog, you can define formulas for all items 
combined in elements. This ensures that item quantities are 
always calculated correctly even when different regulations have 
been defined for individual items (e.g. wall area in m² and wall 
length in m). 

Important! 
To fully exploit the benefits of elements, you should always 
define formulas for items assigned to elements. If you have not 
entered formulas, the quantities of the items in question cannot 
be determined. 

When defining formulas, you can enter all the units required to 
calculate the relevant component in Allplan. These units are 
presented for selection. Customized formulas can also be defined. 

Example: 
A wall with a tiling pattern that is max. 1.50 m high. The formula 
might look like this: m*1.50 

When editing the CAD attributes, you can use an attribute definition 
as a template and simply transfer it from one item to another. 

Note: An overview of the attributes is provided in the online help for 
Allplan, in the chapter entitled "Attributes of Architectural 
Elements". 
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Dynamic Code Text for Items 
"Dynamic code text" is a combination of code text and CAD 
attributes. This means that a predefined Allplan attribute is added as 
a variable to code text of items in the element catalog (not in the 
item catalog). Only when you create quantity takeoff schedules are 
these variables replaced by the actual values defined by the 
dimensions of the Allplan components. This completes the 
generation of "dynamic code text". 

Code text created in this manner serves as an "assignment key" 
when files/element schedules are generated and/or the CAD XUpdate 
tool is executed: item quantities in quantity takeoff schedules are 
assigned to specification descriptions in the item catalog based on 
this code text. 

Important! 
The code text must be exactly the same in both the quantity takeoff 
schedule and the item catalog. Otherwise, the CAD XUpdate tool 
returns error messages, which are saved in the allright.err file. 

You can use any of the attributes defined in Allplan as variables. 
However, the following attributes are particularly important: 

• Length 

• Width 

• Height 

• Volume 

When defining the formula for "dynamic code text", be sure to note 
the following: a + character must be used to append the attribute(s) 
to the end of the basic code text of an item. These attributes are then 
replaced by the component dimensions. The basic code text and the 
variables must be separated by a hyphen; constant parts of the code 
text must be enclosed in quotation marks. 
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Below is an example to illustrate the syntax of "dynamic code text" 
in an element catalog: 

"013.060000-"+ROUND(length*100;1;5)+"-
"+ROUND(thickness*100;1;5) 

  

"013.060000-" constant part: basic code text of the item (e.g. a 
general description of reinforced concrete 
columns) plus hyphen 

+ instructs the program to add the next term 

ROUND instructs the program to round off the value 

Length / thickness variables: CAD attributes that are replaced by the 
actual component dimensions 

*100 conversion of unit to meters and centimeters 

1 number of decimal places 

5 round-off value of the last digit 

  

Example: Thickness of the component in Allplan = 0.257 
cm 

 ROUND(0.257*100;1;5) = 26 

For example, when designing a column that is 
0.365 m long and 0.405 m thick, this "dynamic 
code text" yields the following final code text in 
the quantity takeoff schedule: 

013.060000-36.5-40.5 

  

The code text must be defined in this manner in the item catalog. 
This ensures that the quantities specified in the quantity takeoff 
schedule are assigned correctly to items when files/element schedules 
are generated. 
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Creating a CAD Catalog as an Element 
Catalog 

The sections that follow explain how to create custom CAD catalogs 
for graphical quantity takeoff operations in Allplan Quantities. 

As these catalogs are very complex and setting them up takes much 
time, Nemetschek’s Design2Cost initiative offers you a comprehensive 
database of predefined catalogs and files, which are provided in 
Allplan IntelligenteBauDaten (= Allplan IBD). 

For more information, please visit our website at 
http://www.design2cost.de or contact your Nemetschek sales partner. 
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Defining Materials in 
Allplan 

General information 

You can assign materials to architectural components (walls, 
columns, slabs etc.) while designing using Allplan. If you want, you 
can add rooms to which you assign further material definitions 
based on finishing surfaces. 

Not only do you have the option to assign individual items to 
architectural components and rooms in a single step but you can 
also assign entire elements together with all the associated items 
(provided you have prepared the element catalogs in an appropriate 
manner). If you are using rooms, you can quickly and easily define 
finishing surfaces consisting of multiple layers by selecting entire 
elements right from the beginning. 

In addition to basic items such as "brick" and "plaster", a wall can be 
assigned more items for paint or tiles, for example. You can even 
apply bituminous coating (for sealing against dampness) to the 
"wall" element despite the fact that the quantities of bituminous 
coating are calculated based on a different regulation. To ensure that 
the quantities of the individual items are always calculated correctly 
(e.g. wall area in m² for plaster and paint; wall length in m for 
bituminous coating), you can define formulas for all items in Allplan 
Quantities (more information is provided in the section entitled "CAD 
Attributes for Items". 

Whenever you define materials, you access the catalogs you have 
prepared using Allplan Quantities. 

Note: If you are working with elements, it is important that you 
specify the element catalogs whose elements you want to use when 
defining materials in Allplan (see next section entitled "Define 
Research Projects"). 
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Research projects 

"Research projects" are projects the program scans for elements 
while creating quantity takeoff schedules. In other words, the 
material requirements of these projects are "researched". The 
sequence in which you specify element masters and element 
schedules as research projects also defines the research sequence 
(from top to bottom). 

As the items of elements found can be analyzed only, it is important 
that you only define materials based on element catalogs that are 
actually used for creating quantity takeoff schedules. 

  

Materials for architectural components 

Of course, you can select an individual item in an item catalog when 
defining materials for architectural components. But it is much easier 
and more efficient to select entire elements using element catalogs 
you have prepared for this purpose (cf. section entitled "Setup and 
Structure of CAD Catalogs"). 

  

Materials for finishing and special surfaces 

You can also create finishing surfaces of rooms and special surfaces 
that consist of one or more individual items. Here, too, it is much 
easier and more efficient to select entire elements using element 
catalogs you have prepared for this purpose (cf. section entitled 
"Setup and Structure of CAD Catalogs"). 

Important! 
When defining finishing and special surfaces, be sure to note the 
following: Floor and vertical surfaces (as "normal" finishing 
surfaces) take special surfaces into account. This means that floors or 
vertical surfaces defined as special surfaces have a higher priority 
than ‘normal’ finishing surfaces defined when entering rooms and 
consequently, these special surfaces will intersect normal finishing 
specs at points where they meet (e.g. tiling patterns in plastered and 
painted walls). 
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Component numbers 

You can assign component numbers to all drawing elements in 
finished drawings. This facilitates subsequent processes of 
transferring data to and analyzing and evaluating data in Allplan 
Quantities. 
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Quantity Takeoff 
Operations in Allplan 

When you have finished assigning materials from the Allplan 
Quantities material catalogs to components, you can now create a 
quantity takeoff schedule based on the data obtained from quantity 
takeoff operations and transfer this schedule to Allplan Quantities. 

Important! 
If you are working with elements, it is important that you specify the 
research projects before you create quantity takeoff schedules (cf. 
section entitled "Define Research Projects"). This ensures that all the 
data is processed correctly, which means that item quantities are 
calculated and assigned to the appropriate specification descriptions. 

  

You can define which drawing files or components are to be 
analyzed during quantity takeoff operations in two ways: 

• Selectively - by choosing specific drawing files and the objects 
they contain. 

• Globally - based on several drawing files assembled using a 
"building list". For this, the drawing files in question simply have 
to be selected in the project structure (you do not have to set 
them to active or edit mode). 

Allplan offers an efficient approach for generating quantity 
takeoff schedules encompassing entire structures or buildings. 
You can structure a project's drawing files in a "building list" 
using the following structural levels to assist you: "Structure", 
"Building" and "Story". 
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Further quantity takeoff principles: 

• Quantity takeoff operations work on a cross-file basis (i.e., you 
are not restricted to the information in a single drawing file): 
rooms and the corresponding walls with windows and doors do 
not have to be in the same drawing file. The system will 
nevertheless recognize door and window openings as belonging 
to the room and take these into account during calculations. 

• Neighbor relationships are taken into account: 

- Doors and windows are assigned to the corresponding room. 

- Door openings are assigned to rooms (depending on the 
direction of swing/opening). The floor covering in the door 
opening in the adjacent room is included in the calculation. 

- Slab recesses and openings are recognized as such. 

- Walls recognize each other. 
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Importing Allplan Quantity 
Takeoff Schedules into 
Allplan Quantities 

As the possible applications for graphical quantity takeoff operations 
are manifold, there are a lot of ways in which you can import 
quantity takeoff schedules into Allplan Quantities. 

Important! 
To make sure that all the data is imported correctly, you have to 
specify the item catalog you have used for defining materials. 

The section that follows shows how to import a quantity takeoff 
schedule based on a material definition using an element catalog 
(that was created based on a master file). 

The resulting quantity takeoff schedules are imported into a copy of 
the master file. This ensures that all the items used in Allplan are 
available. 

  

Creating files 

You can create files directly from quantity takeoff schedules. The 
item catalog you have used for defining materials serves as the basis 
for these files. 

Before you import the quantity takeoff schedules, you need to copy 
the item catalog (= master file) whose items you have used to set up 
the element catalog. The original master file is retained. You can 
then import the quantity takeoff schedules into this copy. 
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Updating quantities in existing files 

When you have already created files, you can import the updated 
CAD data directly into existing files. This way, you can quickly and 
easily update quantities. 

Please note the following: 

• Modified quantity calculations are overwritten. 

• Quantity calculations that are no longer required (e.g. quantity 
calculations associated with components you have deleted in the 
meantime) are automatically removed from files. 

• Additional quantity calculations (when you have drawn more 
walls, for example) are added. 

• Specification descriptions that are no longer used are retained as 
"items with zero quantities" in files. If necessary, you can mark 
and then delete them using the Mark zero quantity tool on the 
Calculation menu. 

• New specification descriptions are entered in the log file and can 
be added "manually" to files (cf. section entitled "Checking the 
Log File"). 

• Items and quantity calculations you have entered manually in 
files – i.e. that have not been transferred from Allplan – are 
unaffected by this operation. 

• Items you have locked are not changed. 

  

Checking the log file 

The log file shows the materials and/or quantities that could not be 
assigned correctly during the import. Check the log file entry by 
entry, make the necessary corrections and then update the quantities 
once again. 

This way, you can ensure that the file contains all the materials used 
in Allplan. 
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Tendering 
The "Tendering" chapter deals in detail with all the topics pertinent 
to tendering using Allplan Quantities. 

  

In particular, you will learn how to 

• Create files 

• Define item categories and item types 

• Set up files 

• Insert sketches in files 

• Calculate file quantities 

• Calculate the total costs of files or projects 

• Print files 

• Back up files 

  

 
 

Creating Files 
There are different ways of creating files in Allplan Quantities. Files 
can be based on custom specification descriptions, master data (e.g. 
user-defined master catalogs or master files, predefined text such as 
sirAdos text) or on standard service catalogs. If you created files for 
a similar construction project some time ago, you could also copy 
the relevant project and then modify the specification descriptions. 

A combination of custom text and master text is usually used. In 
practice, users often copy items from similar projects. All the 
possibilities mentioned above can be combined as desired. 
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When items in your files are associated with unit prices of other 
construction projects or with prices in master catalogs, Allplan 
Quantities offers the option to quickly draw up initial cost estimates 
for the relevant trade right from the outset. If you have already 
created files for all the trades, you can also calculate the costs for the 
entire project. 

  

 
 

Creating Files Based on Custom Text 

If no master text is available yet or if the tender is too specific to use 
predefined text, you can create a file based on custom text. Once the 
project is complete, you can copy the text you created from the file 
into a master directory and thus generate your own master text 
catalog. 

  

Creating folders 

The "Folder - Cost" level, which can be inserted between the project 
level and the file level in the hierarchy, allows you to refine the 
hierarchic structure of projects (e.g. taking into account various 
construction stages or components). 

It is not necessary to create a folder line. A structure consisting of 
trades and files is usually sufficient for small construction projects. 
In this case, you insert the file lines below the "Project - Cost" 
hierarchy. 

Important! 
If you want to tender different companies individual titles (in the 
case of tenders based on sections), you must use the "Folder - Cost" 
level for files and the "File - Total/End" level for titles. It is 
absolutely essential that you stick to this hierarchic structure. 
Otherwise, you cannot check quotations as this requires entire files! 

The elements that are directly subordinate to the ‘Folder’ level in the 
hierarchy are totalized in the ‘Folder’ line and the associated cost 
line. 

When you have created a folder, two new indented lines – the folder 
and the cost line - are displayed below the project line in the Type 
column. 



 

Integrated solutions  Tendering 81 
 

Enter descriptive text (e.g. "Component 1") in the Short text column 
of the folder line and a sum name for this construction stage (e.g. 
"Total – component 1") in the Short text column of the cost line. 

Note: You can configure the program to transfer the contents of the 
short text line automatically to the first long text line (provided you 
have enabled the relevant option in the Settings tool on the Extras 
menu). 

  

Creating files 

Subsequent awarding procedures are based on files. A file is created 
for each trade in a project. The "File - Total/End" level cannot 
include any further files. A folder or project, on the other hand, can 
contain several files. Files are always subordinate to the project or 
folder line. 

Important! 
It is essential that you create files as tenderers can only be created 
for files (not possible for folders, titles or items)! Otherwise, you 
cannot check any quotations! 

The costs of the items that are directly subordinate to the ‘File’ level 
in the hierarchy are totalized in the ‘File’ line and the associated 
total/end line. 

When you have created a file, two new indented lines – the file and 
the total/end line - are displayed below the project or folder line in 
the Type column. 

Enter text (e.g. "Unfinished structure work") in the Short text 
column of the file line and a sum name for this trade (e.g. "Total – 
Unfinished structure work") in the Short text column of the 
total/end line. 

  

Create titles 

Titles refine a file’s structure and are usually used for service types. 
You can subordinate an unlimited number of titles of the same level 
in the hierarchy to a file. 

The "Title - Total/End" level can include any number of subordinate 
titles (for example, the "Masonry work" title can consist of the 
subordinate "Exterior walls", "Interior walls" etc. subtitles). 
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The elements that are directly subordinate to the relevant title in the 
hierarchy are totalized in the ‘Title’ line and the associated total/end 
line. 

When you have created a title, two new indented lines – the title and 
the total/end line - are displayed below the file line in the Type 
column. 

Enter the service type (e.g. "Earthwork title") in the Short text 
column of the title line and a sum name for this title (e.g. "Total – 
Earthwork title") in the Short text column of the total/end line. 

Note: To create subtitles for a title, place the insertion marker in the 
total/end line of the relevant title and repeat the steps above. 

  

Creating items 

Items are data records of the lowest level in the hierarchy. You 
cannot create any items that are subordinate to items. Consequently, 
items consist of one line only (an associated sum line does not 
exist!). 

The sections that follow explain how to turn "empty" items into 
specification descriptions. 

  

Creating comments 

Comments can be used to describe files, titles, subtitles and items 
more precisely. As with items, comments are data records of the 
lowest level in the hierarchy. You cannot create any comments that 
are subordinate to comments. 

To assign a comment to a title, place the insertion marker in the first 
item line of the relevant title. 

If this title does not contain any items, place the insertion marker in 
the title’s total/end line. To create a comment that precedes one or 
more items, place the insertion marker in the item line of the first 
item to which you want to assign this comment. 

Note: To add text notes to files, you can also define items as text 
items. This item category is used exclusively for purely "textual" 
files and must not be used within GAEB-compliant files (for details 
see "Assigning Categories and Types of Items in Compliance with 
GAEB Guidelines"). 
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Creating tenderer text supplements 

A tenderer text supplement is additional information on the long 
text (e.g. item number or finish definition) that the tenderer may be 
requested to provide in the quotation. Tenderer text supplements can 
be added to one or more items. 

  

Editing specification descriptions 

You have created a file with one or more titles containing one or 
more empty items to which text, dimensions, quantities etc. need to 
be assigned. If you want to perform initial cost calculations for the 
trade right from the outset, you need to enter estimated unit prices. 

If you are working with the DIN 276 optional module, it is advisable 
to define DIN 276 cost groups. 

  

 
 

Creating Files Based on Master Data 

Besides using custom text, you can also create files based on master 
data such as user-defined master text, predefined text (e.g. sirAdos 
text) or existing files. 

Creating files based on master data involves the following steps: 

• Open the data sheet containing the master data. 

• Display or select the prices that are to be copied to the new file 
and that are to serve as the basis for initial cost calculations. 

• Select the desired items in the master data. 

• Copy the selected items, including prices, to the new file. 
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Selecting Estimated Prices in the Master Catalog 

Data records saved as master data usually contain several price lines 
(e.g. items with several estimated prices in a master catalog). When 
you copy data records (e.g. items from a master catalog to a new 
file), Allplan Quantities automatically copies a price for each data 
record. 

Prior to copying, you can specify which price is transferred to the 
new file using one of the following options: 

• To use the prices of a single tenderer, display the prices of this 
tenderer only. 

• To use the prices of two or more tenderers, display all the price 
lines and select the line with the price you want to use for each 
item. These can be price lines of different tenderers. 

Note: You can also copy the prices of one or more tenderers (e.g. the 
average prices of the MID tenderer) to an existing file later. Detailed 
information is provided in the "Cost Calculation" section. 

  

 
 

Selecting Data Records in Master Catalogs 

Allplan Quantities allows you to copy entire folders, files and titles 
as well as individual items and comments quickly and easily. When 
creating files based on master data, this is very useful as you can 
select specification descriptions including prices and hierarchic 
structures from a master catalog and transfer this data to a new file 
in a single step. Start by selecting data records in the master catalog. 

If you know the item number or code text of the specification 
descriptions, you can also enter this information directly. 

Note: When you select entire levels in the hierarchy in a single step, 
only the prices of a single tenderer can be used for the individual 
levels in the hierarchy. To transfer the prices of different tenderers, 
you need to select the price lines individually. 
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Copying Data Records from the Master Catalog to a File 

The process of copying data records is easy: select the relevant data 
records, activate the tool you want to execute, place the insertion 
marker as you need in the new file and insert the data records there. 
You can also drag and drop the selected data records out of the 
master catalog into the new file. 

  

When you copy and insert folders, files, titles, items or comments, it 
is important that you take the hierarchic structure into account: 

 Project 
  Folder 
   File 
    Title  
     Comment 
     Item 
     Item 
     Item 
    Total/End Title 
   Total/End File 
  Cost Folder 
 Cost Project 

To copy a title to the end of a file, place the insertion marker in the 
file’s total/end line before you insert the title. When, for example, a 
copied title is to precede another title, place the insertion marker in 
the title line which is to be preceded by the new title prior to 
inserting. When inserting items, place the insertion marker on the 
item that is to follow the item to be inserted. 

Note: When you transfer specification descriptions from an existing 
file to a new file and copy data records without opening the dialog 
box for copying data, quantity calculations are automatically copied 
at the same time. If you do not want to transfer these quantity 
calculations to the new file, you need to copy the data records 
without quantity calculations using the dialog box for copying data 
records. Alternatively, delete the quantity calculations later. 

Including quantity calculations in copy operations can be useful 
when you want to create an alternative or contingency item based 
on a "normal" item, for example. 
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Creating Files Based on the StLB 

The standard service catalog (= StLB), which is issued by the German 
Institute of Standardization, is designed for describing any tasks 
related to construction work - ranging from the building process 
itself to maintenance and management of buildings and real estate. 

In Germany, the StLB is used especially for public tenders. 

Text in the standard service catalog consists of five parts. A number 
of variants is available for each part. These five text parts are 
structured hierarchically. Users can choose one of the variants 
presented on each of the five levels in the hierarchy. Each text 
variant in the standard service catalog includes a specific number. 

The advantage of the StLB is that it provides standard specification 
descriptions, which can be understood by everyone. A disadvantage, 
however, is that estimated prices cannot be entered. 

Note: Before you can create a file based on the StLB in Allplan 
Quantities, you need to purchase the relevant service types from the 
Beuth Verlag in Germany and install them. 

  

Installing and deleting StLB service types 

The individual service types of the standard service catalog can be 
purchased on storage media from the Beuth Verlag in Germany. 

By installing the StLB, the files on the storage medium are imported 
to the hard disk and automatically converted to a data format that 
can be processed by Allplan Quantities. 

You can delete service types you no longer require from the hard 
disk to free up disk space, for example. 
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Printing StLB service types 

You can print the service types you have installed. The printout has 
the same layout as the original standard service catalog. 

  

Creating a file using the StLB 

Specification descriptions based on the StLB are defined using the 
Standard Service Catalog processing template. 

Some text parts in the StLB include additional text. Depending on 
the selected text part, there are three types of additional text: 

• Additional text which must be entered by the party issuing the 
invitation to tender. 

• Additional text which can be entered by the party issuing the 
invitation to tender; the tenderer must enter additional text if the 
party issuing the invitation to tender has not done this. 

• Additional text which must be entered by the tenderer. 

  

Editing specification descriptions based on the StLB 

Normally, you cannot edit specification descriptions you have 
created based on the StLB. In other words, you cannot modify short 
or long text, for example. However, you can convert individual StLB 
items to open text items, which are editable. In this case, the StLB 
code of the relevant item is deleted automatically and the additional 
text "Based on StLB no. ....." followed by the StLB number is added 
to the item’s long text. 

  

 
 

Creating Files Using STLB-Bau or DBD 

When you have purchased the "STLB-Bau Dynamische Baudaten" 
and/or "DBD Dynamische Kostenelemente" CD, you can also use the 
specification descriptions of these databases for Allplan Quantities. 
To install this application, follow the instructions given by STLB-
Bau. The CD includes the entire range of items provided by STLB-
Bau. The data that is actually available to you depends on the license 
you have purchased. If you can access the demo data only, please 
contact the CD supplier. 
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Note: Before you work with "STLB-Bau Dynamische Baudaten" 
and/or "DBD Dynamische Kostenelemente", check that this 
application has been installed correctly. 

The "STLB-Bau Dynamische Baudaten" or "DBD Dynamische 
Kostenelemente" database can be accessed using the STLB-Bau 
Dynamische Baudaten / DBD - Dynamische Kostenelemente 
processing template which has been specially developed for this 
application. This processing template assists you in the process of 
creating and editing text. The data you set up in this application can 
be imported quickly and easily to Allplan Quantities. 

You can use this processing template to create one or more items in 
a single step. The item text is transferred straight to the current data 
sheet and can be changed at any time. All you need to do is open the 
relevant processing template and modify the transferred item. 

Text that is still missing information can be completed automatically 
in this processing template without you having to start "STLB-Bau" 
and/or "DBD". In addition, this processing template allows you to 
check that text is complete and valid. 

Icon Use 

 You can use this tool to unlock an STLB-Bau item. The item is 
not a standard item any longer and can be edited freely (only 
available if the item is STLB-Bau text). 

 You can use this tool to create a new item based on STLB-Bau. 
Click OK to exit STLB-Bau. The new item is inserted below the 
current item. 

 You can use this tool to create several new items based on STLB-
Bau. Click OK in STLB-Bau to transfer text to Allplan Quantities 
and select the next text you want to use. Click Cancel to exit 
STLB-Bau. The new items are inserted below the current item. 

 You can use this tool to modify the current item in STLB-Bau 
(only available if the item is STLB-Bau text). 

 You can use this tool to automatically complete the definition of 
an STLB-Bau item that is still missing information (only available 
if an STLB-Bau text is still incomplete). 

 You can use this tool to delete the current item. 

 You can use this tool to display the key number of a specific text 
(only available if the item is STLB-Bau text). 

  

Tip: Please consult the "STLB-
Bau Dynamische Baudaten" 
and "DBD Dynamische Kosten-
elemente" documentation for 
details. 
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The text of an STLB-Bau item is standard text. It cannot be modified. 
However, when tenders do not necessarily have to be based on StLB, 
you can customize this text by removing the write protection. 

When you have purchased "STLB-Bau mit Baupreisen", the unit 
prices calculated are transferred to Allplan Quantities. 

  

 
 

Creating Files Using HeinzeBauOffice 

When you have purchased the BauOffice CD from Heinze, you can 
use the specification descriptions provided in this database for 
Allplan Quantities. To install HeinzeBauOffice, follow the 
instructions given by Heinze. The CD includes the entire range of 
items provided by Heinze. The data that is actually available to you 
depends on the license you have purchased. If you can access the 
demo data only, please contact Heinze. 

Note: Before you can import Heinze specification descriptions, you 
have to install HeinzeBauOffice. 

You can activate HeinzeBauOffice straight from Allplan Quantities 
using the HeinzeBauOffice processing template. The data you 
assemble in this application can be imported quickly and easily to 
Allplan Quantities. The data, which is transferred via the GAEB 
interface, is entered in the open data sheet. 

  

Besides the buttons provided by all Allplan Quantities processing 
templates (at the bottom left), the HeinzeBauOffice processing 
template includes the following additional tools: 

Icon Function Use 

 Create new item You can use this tool to create a new item. 

 Create master item You can use this tool to create a master item. 

 Create custom item You can use this tool to create a custom item. 

 Revise text of this item You can use this tool to modify the text of an 
item. 

 Research You can use this tool to research an item. 

Tip: Please consult the 
HeinzeBauOffice 
documentation for details. 
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Icon Function Use 

 Delete item You can use this tool to delete the current item. 

 Settings You can use this tool to make settings for 
interfacing with HeinzeBauOffice. 

   

  

Importing individual items straight from HeinzeBauOffice 

Items are always transferred to Allplan Quantities. This applies 
regardless whether you create master or custom items. 

The difference is that you cannot specify the contents of long text in 
HeinzeBauOffice when you use master items. 

In the case of custom items, however, you can quickly and easily 
define the contents of the items yourself by selecting the relevant 
questions. 

You can also combine master and custom items. 

  

Options for HeinzeBauOffice 

To harness all the advantages provided by using HeinzeBauOffice in 
conjunction with Allplan Quantities, the options need to be set 
correctly. This is done automatically when you install 
HeinzeBauOffice and then start Allplan Quantities. However, if these 
settings have been modified, you need to correct them manually. 

  

 
 

Creating Files Using sirAdos Building Data 

When you have purchased sirAdos®-Baudaten, you can also use the 
sirAdos item and element catalogs for tendering in Allplan 
Quantities. To do this, install sirAdos-Baudaten as described in the 
sirAdos/WEKA MEDIA installation instructions. 

The data that is actually available to you depends on the license you 
have purchased. If you can access the demo data only, please contact 
sirAdos. 
 

Tip: Master items that have 
already been transferred to 
Allplan Quantities can be 
edited at any time. 
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Creating Master Text for Allplan Quantities Based On 
sirAdos Building Data 

As opposed to previous versions of sirAdos Building Data (e.g. 
sirAdos-select), the latest the sirAdos Building Data CD does not 
contain any prepared MDI files with the complete trades. This way 
you can choose which trades and items you want to transfer and 
generate your own MDI files in sirAdos Building Data for data 
transfer to Allplan Quantities. 

You can import the generated MDI files into Allplan Quantities 
through the MDI interface and then create your own masters, 
element masters, files or element schedules based on this data. 

Note: As complex projects increase the computing time, it is 
advisable to define a maximum of 15 trades per master catalog. You 
should therefore spread master text among several master catalogs. 

  

 
 

Importing Individual Items from the sirAdos Building Data 
CD into Allplan Quantities 

If you do not want to manage your own item masters with sirAdos 
text, you can use the sirAdos Building Data CD as a master. The 
advantage is that you need much less hard disk space and that you 
can immediately use the text provided on the CD without having to 
install it first (in the case of updates, for example). 

  

You can import one or more sirAdos items from one or more titles 
either into the buffer database or directly into your current file in 
Allplan Quantities. The contents of the buffer database can be 
inserted anywhere into any project at any time (if the data types 
match). 

The data can be pasted into a file at the position of the insertion 
marker or it can be sorted by code text number. In the latter case, 
the Calculation data sheet must be open. 
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Two options are provided for importing data to files and to the 
buffer database: 

• sirAdos text is pasted at the position of the insertion marker 
(default) - requirement: the Sort after insertion option in the 
Settings dialog box must be deactivated. All the levels in the 
hierarchy (titles) are removed from the buffer. Irrespective of the 
sequence and trade from which it originates, text is always pasted 
at the current position of the insertion marker in the data sheet. 

• sirAdos text is sorted and inserted in a file - requirement: the 
Sort after insertion option in the Settings dialog box must be 
activated. With this method, it is important that you maintain the 
Codetext column as the items in a file are sorted by this column. 
Consequently, this method cannot be used with elements and 
masters without file lines. 

However, it is particularly useful when you create files using 
sirAdos text only. When the data is pasted in the data sheet, all 
the lines in the buffer are taken into account. Note, however, that 
only the lines whose code text numbers do not yet exist in the 
file are inserted. The lines to be inserted are sorted by code text 
number and added to the file accordingly. 

Important! 
Before you can import individual sirAdos items directly into Allplan 
Quantities, you have to install the sirAdos Building Data CD and 
correctly configure the online interface between sirAdos and Allplan 
Quantities. 

  

 
 

Creating Files Using a Bar-Code Reader 

You can use bar-code readers to quickly and easily create files based 
on sirAdos master text, for example. All you need to do is scan the 
bar-code label of an item using a bar-code reader and copy the 
selected specification descriptions to a project in a single step. That's 
all! 
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Note: Bar-code readers do not come with Allplan Quantities. As they 
must be consistent with the bar-code labels used in specification 
descriptions, bar-code readers are usually distributed by the 
providers of tender text. 

  

Preparations for using bar-code readers 

Connect the bar-code reader or another suitable input device to your 
computer as described in the documentation provided by the 
manufacturer of the device. 

In addition, you need to install all the specification descriptions you 
want to select with the bar-code reader as a master catalog in 
Allplan Quantities. 

  

Creating a file using the bar-code reader 

You can only create a file in this manner when all the specification 
descriptions you want to select using the bar-code reader are 
available as a master catalog in Allplan Quantities. In addition, the 
specification descriptions including suitable bar-code labels must be 
available on paper. These requirements are met by sirAdos text, for 
example. 

  

 
 

Adding Specification Descriptions Using the BRUNS Plant Catalog 

General information 

You need to purchase a license in order to use plant catalogs in 
conjunction with Allplan Quantities. Otherwise, the functions for 
editing plant catalogs are not available to you. 

The Allplan DVD includes the specification descriptions of the 
BRUNS Plant Catalog 2004/2005. This project, which has already 
been converted to Allplan Quantities format, is located in the 
directory <dvd>\programs\Allplan BCM\Demodaten_Bau-
kosten\Stämme on the CD and can be loaded using Allplan 
Quantities’ archive administration. 
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Note: Updated versions of the BRUNS Plant Catalog (if any) can be 
obtained directly from BRUNS. How to import this data in Allplan 
Quantities is described below in the "Importing the BRUNS Plant 
Catalog from floppy disk" section. 

  

Plant Disposition processing template 

Allplan Quantities provides a special processing template for creating 
text using the BRUNS Plant Catalog: the Plant Disposition 
processing template. 

You can use this template to select plants and generate estimated 
prices for cost estimates. The master project called 
"BRUNS Plant Catalog" serves as the basis. 

Icon Function Use 

 Create new item You can use this tool to create a new item based 
on a specification description from the plant 
catalog. 

 Edit item You can use this tool to modify an item based 
on a specification description from the plant 
catalog. 

 Delete item You can use this tool to delete an item based  
on a specification description from the plant 
catalog. 

   

Important! 
Activate the Apply price check box to automatically transfer the 
unit price from the price list according to the quantity entered. 

  

Using the price list of the BRUNS Plant Catalog 

The BRUNS Plant Catalog contains a price list with prices for all the 
plants including quantity discounts (the discounts allowed vary 
depending on the selected plant). 

Allplan Quantities automatically recalculates the prices in the 
processing template when you change the quantity. When you have 
activated the Apply price check box, the unit price is copied from 
the price list, taking quantity discounts into account. When the 
Apply price check box is deactivated, you enter the price directly. 
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As quantity data can also be entered using quantity takeoff operations 
or via the CAD interface, for example, you can update the prices and 
quantity discounts in the processing template for all the plants selected 
from the BRUNS Plant Catalog. 

  

Data exchange between Allplan and Allplan Quantities 

In order for the data exchange between Allplan and Allplan Quantities 
to run smoothly, the two programs must use the same master data. 
The master data provided by Allplan Quantities is managed as a 
material catalog in Allplan. The essential data field is the Code text 
column. 

If Allplan and Allplan Quantities are installed on the same computer 
or if the Allplan data directory is shared on the network, you can 
enter the destination path directly. 

Note: More detailed information on exchanging data between Allplan 
and Allplan Quantities is provided in the chapter entitled "Quantity 
Takeoff Operations using Graphics". 

  

Importing the BRUNS Plant Catalog from floppy disk 

Updated versions of the BRUNS Plant Catalog (if any) can be obtained 
directly from BRUNS. Before you can create tenders in Allplan 
Quantities using these up-to-date specification descriptions, which 
you are given on a floppy disk, this data needs to be imported into 
Allplan Quantities as a master project. 

The BRUNS Plant Catalog is provided as a self-extracting EXE file. 
Copy the BRUNS catalog file to a temporary directory on your hard 
disk or network and unpack it by executing the file. Once the plant 
catalog has been imported in Allplan Quantities, you can delete the 
temporary directory, including the BRUNS catalog file. 

Note: The catalog file requires approx. 30 MB, the Allplan Quantities 
master project that is created requires 60 MB of free hard disk space. 
Before you start unpacking or importing the catalog file, make sure 
that you have enough free hard disk space. 
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Adding Specification Descriptions Using GreenBASE Plant Disposition 

General information 

You need to purchase a license in order to use plant catalogs in 
conjunction with Allplan Quantities. Otherwise, the functions for 
editing plant catalogs are not available to you. 

When you have purchased the GreenBASE Plant Disposition CD from 
GreenX, you can also use these plant lists for Allplan Quantities. To 
install GreenBASE Plant Disposition, follow the instructions given by 
GreenX. The data that is actually available to you depends on the 
license you have purchased. If you can access the demo data only, 
please contact GreenX. 

There are two ways to use the GreenBASE Plant Disposition 
application: 

• You can create a catalog containing the plants you selected 
(including quality and price details). You can then use this 
catalog as a master catalog for creating tenders in Allplan 
Quantities or you can export it as a material catalog to Allplan. 

• While creating files in Allplan Quantities, you can directly access 
the GreenBASE Plant Disposition application, select plants in its 
extensive database and paste these plants into a file (see the 
section entitled "Transferring GreenBASE plants directly to 
projects"). 

  

Plant Disposition processing template 

Allplan Quantities provides a special processing template for creating 
text using GreenBASE Plant Disposition: the Plant Disposition 
processing template. 

You can use this template to select plants and generate estimated 
prices for cost estimates. The master project called 
"GreenBASE Plant List" serves as the basis. 
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Icon Function Use 

 Create new item You can use this tool to create a new item based 
on a specification description from the plant 
catalog. 

 Edit item You can use this tool to modify an item based 
on a specification description from the plant 
catalog. 

 Delete item You can use this tool to delete an item based on 
a specification description from the plant 
catalog. 

   

Important! 
Activate the Apply price check box to transfer the unit price from 
the price list automatically, according to the quantity entered. 

  

Using the price list of GreenBASE Plant Disposition 

The GreenBASE plant catalog contains a price list with prices for all 
the plants including quantity discounts (the discounts allowed vary 
depending on the selected plant). 

Allplan Quantities automatically recalculates the prices in the 
processing template when you change the quantity. When you have 
activated the Apply price check box, the unit price is copied from 
the price list, taking quantity discounts into account. When the 
Apply price check box is deactivated, you enter the price directly. 

As quantity data can also be entered using quantity takeoff 
operations or via the CAD interface, for example, you can update the 
prices and quantity discounts in the processing template for all the 
plants selected from the plant catalog. 

  

Data exchange between Allplan and Allplan Quantities 

In order for the data exchange between Allplan and Allplan Quantities 
to run smoothly, the two programs must use the same master data. 
The master data provided by Allplan Quantities is managed as a 
material catalog in Allplan. The essential data field is the Code text 
column. 
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If Allplan and Allplan Quantities are installed on the same computer 
or if the Allplan data directory is shared on the network, you can 
enter the destination path directly. 

Note: For more detailed information on exchanging data between 
Allplan and Allplan Quantities, please consult the manual entitled 
"Quantity Takeoff Operations using Graphics". 

  

Transferring GreenBASE plants directly to projects 

When you do not manage your own plant master with all the 
GreenBASE plants, you can use GreenBASE Plant Disposition as a 
master catalog. For this, you can import individual plants from 
GreenBASE directly into the current projects. 

The advantage of this is that you require not so much hard disk 
space and that you can immediately use the text provided on the CD 
without having to install it first (in the case of updates, for example). 

You can copy one or more plants straight to the current file. The 
selected plants are inserted where the insertion marker is located in 
the file. 

If the plant items created in the file have been generated including 
BRUNS price details, you can assign the relevant quantity-based unit 
prices to the items by using the Plant Disposition processing 
template. For details, see the section entitled "Update the Price List 
According to the GreenBASE Plant Catalog". 

Note: Before you can import GreenBASE plants, you have to install 
the GreenBASE CD. 

 
 

Create Files Based on CAD Data 

When you have created a three-dimensional building in Allplan and 
used the specification descriptions prepared by Allplan Quantities to 
define the materials of the components, you can create a special 
Allplan Quantities schedule including the item quantities calculated 
during quantity takeoff operations. 

This quantities schedule is transferred to Allplan Quantities and, 
based on the code text, the quantities specified in this schedule are 
associated with the specification descriptions of Allplan Quantities. 
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As you go along, the files/element schedules created in this manner 
can be evaluated and edited according to various criteria. 

Note: A detailed description is provided in the section entitled 
"Importing Quantity Takeoff Schedules into Allplan Quantities (see 
"Importing Allplan Quantity Takeoff Schedules into Allplan 
Quantities" on page 77)". 

 
 

Create Files Based on Element or Room Schedules 

When element and/or component calculations are performed, several 
items of different trades are used to calculate elements that represent 
entire components. A possible element, for example, would be an 
interior wall consisting of masonry, plaster, wallpaper, paint and 
baseboard. 

Using these elements, Allplan Quantities creates a project-specific 
element schedule, which can then serve as a basis for automatic 
generation of trade-specific files. In other words, when an element 
schedule is used to create a file, the items of different trades of an 
element are written to the relevant trades in accordance with the 
structure of the master data. 

Note: A brief description of generating files based on element 
schedules is provided in the section entitled "Creating a CAD Item 
Catalog (Master File) Based on an Element Catalog". 

 

 
 

Defining Item Categories and Item Types 
Files often contain not only normal items, which are added up, but 
also other item categories and types: alternative items, for example, 
replace normal items. If needed, contingency items may be added in 
case special services are required. A basic item is a normal item with 
one or more alternatives. In printouts, text items are larger than 
other items as they do not contain any prices or quantities. You can 
also use the 'Text' item category to give preliminary notes a 
hierarchical structure, for example. 
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The calculation results of files vary depending on the item categories 
used. For example, normal, requirement and basic items are taken 
into account when the total price is calculated. Contingency and 
alternative items, on the other hand, are excluded. You can combine 
these categories with item types. By defining reference items and 
repetitive items, you can create cross-references between items. 

As categories and types of items can be reset and redefined at any 
time, you can quickly and easily calculate a number of variants 
when drawing up initial cost estimates or checking quotations. 

The categories and types of items are defined in the Properties of 
(name of item) dialog box. 

Note: When you want to exchange GAEB-format files with design 
partners, you have to take into account the special conditions for 
defining categories and types of items. For detailed information, 
please see "Exchanging Data via the GAEB Interface". 

  

You can enter the item categories most commonly used in practice 
directly in the Type column: 

• Alternative item 

• Requirement item 

• Contingency item 

• Basic item 

• Normal item 

• Text item 

If these item categories do not meet your requirements, you can also 
use the Properties of (name of item) dialog box to define items. 

  

Points to bear in mind when defining categories and types of items: 

• Basic item associated with alternative item – a basic item must 
be defined for each alternative item! One or more alternative 
items must be assigned to each basic item. These assignments are 
made using assignment numbers. 

• Reference item associated with repetitive item – a repetitive item 
requires a reference item whose item number has to be entered as 
the reference. 
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• Implementation description associated with repetitive item – an 
item relating to an implementation description requires an 
implementation description whose number has to be entered as 
the reference. 

• Main description and sub-description – main descriptions 
always require sub-descriptions and vice versa. When files are set 
up, sub-descriptions have to be assigned consecutive, two-digit 
values in ascending order starting with 01. 

• Special notes on DA82 – items without total prices cannot be 
exported. Basic items are treated as normal items. Open tenderer 
quantities have to be specified. 

• Requirement and contingency items are mutually exclusive in 
files. 

• Comments – text supplements to be entered by tenderers cannot 
be added to comments. 

• Quantity and dimension – quantities and dimensions have to be 
specified for items. 

  

 
 

Setting up Files 
Files can basically be organized and structured to suit your own 
needs and requirements. Allplan Quantities provides an easy-to-use 
algorithm that sets up files and automatically assigns item numbers 
according to your settings. How this is done is described in the 
section entitled "Setting up Standard Files". 

When you want to exchange GAEB-format files with design 
partners, however, the files have to be set up in compliance with the 
GAEB guidelines. The requirements that must be met as well as the 
options offered by Allplan Quantities are described in the section 
entitled "Setting up Files in Compliance with GAEB Guidelines (on 
page 107)". 
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Setting up Standard Files 

You can set up files manually by entering item numbers in the Item 
no. column of the data sheet. But it is much easier to use Allplan 
Quantities’ automatic algorithm. 

In automatic mode you can choose to set up files 

• by applying a logical structure, 

• by using consecutive numbers or 

• in compliance with GAEB guidelines. 

 

In addition, you can specify whether file, title and/or item lines are 
to be set up, define the values at which the operation is to start and 
decide which fillers and separators are to be used. 

  

The data line in which the insertion marker is currently placed and 
all the associated, subordinate data records in the hierarchy can be 
set up in a single step. When, for example, the insertion marker is in 
a file line, this line and all the subordinate titles, items and/or 
comments can be set up. To set up an entire project including all the 
subordinate files, you need to place the insertion marker in the 
project line. 

Note: When you want to exchange GAEB-format files with design 
partners, you have to take into account the special conditions for 
assigning item numbers. Detailed information is provided in the 
"Exchanging Data via the GAEB Interface" chapter. See the section 
entitled "Setting up Files in Compliance with GAEB Guidelines (on 
page 107)". 

You can set up files as often as you want; the results are always 
displayed immediately. This way, you can quickly and easily test a 
wide range of options of structuring files by combining the different 
criteria and thus find the setting best suited for your purpose. 

  

  

The examples that follow illustrate some basic options for 
structuring your files. 
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Example 1: 

In the first example, the default setting was used. The insertion 
marker was placed in the project line before setting up the file: 

  

Using these settings ... 

 

  

… the result might look like this: 

 

  

 



 

104 Tendering Allplan BCM  

Example 2: 

In the next example, the width of format was set to three characters 
and "0" was selected for the filler; the text "R / 013." is to be applied 
to the title "Concrete and R.C. works". The insertion marker was 
placed in this title line before setting up the file: 

  

Using these settings ... 

 

  

… the result might look like this: 
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Example 3: 

In this example, a standard numeration was entered that is to apply 
to items only; the width of format was set to five characters and "0" 
was selected for the filler so that up to 99,999 items can be numbered 
using a consistent logical system; no separator was specified. The 
insertion marker was placed in the file line before setting up the file: 

  

Using these settings ... 

 

  

… the result might look like this: 
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Example 4: 

In the fourth example, the file was set up using the GAEB numeration 
suggested by Allplan Quantities. To set up a file in this manner, you 
have to place the insertion marker in the file line (required by GAEB 
guidelines). You can then click the Suggestion button to use Allplan 
Quantities’ suggestions: 

  

Using these settings ... 

 

  

… the result might look like this: 
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Setting up Files in Compliance with GAEB Guidelines 

Files you want to exchange via the GAEB interface have to be set up 
in compliance with GAEB guidelines. The "Set up files in GAEB format" 
feature lets you set up files quickly and easily. 

Allplan Quantities automatically creates a key for ordinal numbering 
(= ON key), which you can accept or modify (even at a later stage). 
Based on the format of this ON key, Allplan Quantities then sets up 
the entire file in ascending order. 

  

The ON key, which consists of a maximum of nine digits, defines the 
format of the item numbers to be assigned. The characters of the ON 
key represent the number of digits for the individual levels in the 
hierarchy, the items and the item index. 

For example, the "1122PPPPI" ON key creates the following item 
number: "01.22.  12a". "01" is the number of the first title in the 
hierarchy, "22" is the number of the second title, "  12" is the item 
number and "a" the item index. 

Note: The item index is not used in Allplan Quantities. 

The result might look like this: 
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Important! 
Comments and the ‘Sub-description’ and ‘Execution description’ item 
categories are not set up automatically. You can use the "Change 
item category" tool to assign consecutive numbers to these item 
categories when defining them. 

  

 
 

Add Images and Sketches 
Allplan Quantities allows you to integrate objects in order to touch 
up your files. This way, you can enhance simple text by adding 
graphics or even acoustic elements – making things a lot clearer! 
These objects can be images or, depending on your hardware, audio 
elements or videos. In practice, however, images are most commonly 
used. 

The "Basic Introduction" chapter provides detailed information on 
"Object Fields and Object Windows" and describes the process of 
"Inserting Objects in Object Windows". 

When you copy specification descriptions from master text where 
sketches have already been inserted, these sketches are automatically 
included in the copy operations. 

When you select an appropriate report, the objects integrated in a 
file are included in printouts. 

  

 

Determining File Quantities for Tenders 
Your file contains the specification descriptions, the definition of the 
item categories and the item numbers. All that is still missing in the 
tender is the file quantities. 
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There are basically two ways to enter quantities in files. You can 

• specify quantities by direct entry in the Quantity column 
(individual quantities cannot be determined; quantities cannot be 
split) or 

• calculate quantities using quantity calculations (individual 
quantities are easy to determine; quantities can be split). 

Which method is to be preferred depends on various aspects: 
entering quantities directly is easier, but usually only suitable for 
small construction projects and only if the quantities do not have to 
be split up. 

The initially more complex method of using individual quantity 
calculations is preferable when you transfer the item quantities from 
several different components or when you want to split quantities, 
i.e. if the quantities used are to be allocated to various construction 
projects or clients. To assist you in defining and using quantity 
calculations, Allplan Quantities offers a processing template as well 
as the possibility to enter custom calculations, REB formulas and 
variables. 

Note: More detailed information on calculating quantities is 
provided in the "Conventional Quantity Takeoff Operations" chapter. 

  

 
 

Calculate the Total Costs of Files or Projects 
You have created and set up the file, and calculated the file 
quantities. When all items of the file have been assigned estimated 
prices, you can already perform initial calculations to determine the 
estimated total costs of the file or entire project. This is the case, for 
example, when you have created the file based on master text or a 
master file and transferred the specification descriptions together 
with the associated prices. 

Note: If no prices have been assigned, you need to enter them before 
you can calculate the costs. How this is done is described in the 
chapter entitled "Calculating Costs", in the "Cost Calculation" 
section. 

Tip: When choosing the 
method, spend some time 
thinking ahead: how do you 
want to determine the 
quantities in subsequent 
phases of the project? One 
advantage of quantity 
calculations is that they can 
be used throughout the 
project, from setting up the 
file all the way through to 
invoicing. 
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Printing Files 
You have created the file and calculated the file quantities. All you 
need to do now before dispatching the file is print it. 

  

Note: More detailed information on printing and alternative output 
options (e.g. output to MS Word or output in RTF, HTML or PDF 
format) is provided in the section entitled "Printing Files, Cost and 
Quantity Calculations". 

  

Important! 
To add a cover sheet to a file, you need both the project data (e.g. 
name of client, project name etc.) and the file data. Please make sure 
that this data is complete. Where this data needs to be entered is 
described in detail in the "Data for the File Cover Sheet" section. 

  

 
 

Back up Files 
Printing and dispatching a file marks the end of the first stage in 
editing files. At this point in time, at the latest, you should create a 
backup of the project. not only to be able to restore it in case of data 
loss, but also to document the file contents at the different phases of 
the construction project. Allplan Quantities' Archive Administration 
tool therefore offers quick and easy backup options. 

More detailed information is provided in the "Backing Up Data and 
Archiving Projects" chapter. See the section entitled "Backing up and 
Archiving Projects Using the Archive Administration Tool". 
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Cost Calculation 
You have created a file and transferred the quantities from Allplan 
or calculated and entered them manually. You can now calculate the 
preliminary total costs of the file or entire project, provided that the 
estimated prices have been entered in the relevant price columns. 

If you have created the file based on master data (such as user-
defined master catalogs/files or predefined text provided by e.g. 
sirAdos or STLB-Bau), you generally use the prices specified in the 
specification descriptions provided by the master data; in this case, 
the price columns already include estimated prices. 

If, on the other hand, you have created the file based on custom text, 
StLB or other specification descriptions that do not contain any 
estimated prices, you need to enter these prices manually. 

  

Note: For calculating costs, it is a good idea to set up the data sheet 
as follows: Hide all the columns that are not relevant to the 
calculations. Alternatively, you can divide the data sheet into two 
viewports. The descriptive "text block" (Type, Item no., Short text, 
Long text columns) is then displayed in the window on the left. The 
"price block" (MP, WP, UP, TP checked columns and, if applicable, 
the % +/-, TP eff., % VAT, TP grs columns) is shown on the right. 

  

 
 

Entering or Changing Prices 
You can enter prices manually or change the estimated prices copied 
from a master file, master catalog or from other projects later. Either 
way, you can enter just a unit price or break down the unit price 
into up to 6 wage and/or material price portions (= unit price 
allocation). 
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When using the unit price allocation, the values in UP1 to UP6 and 
UP are interrelated in the following ways: 

• If you enter values in the UP1 to UP6 columns/input fields, the 
unit price UP is automatically calculated by adding up the values 
currently entered in UP1 to UP6: 

UP1 + UP2 + ... + UP6 = UP 

• If you enter a value in UP, the unit prices are allocated based on 
the following rules: 
If UP1 to UP6 contain values and you change the value in UP, 
this value is divided between UP1 to UP6 in proportion to the 
original values. 
If UP1 to UP6 are empty or set to "0.00", and if the 
Automatically calculate material and wage prices option is 
activated in the Settings dialog box, the value entered in UP is 
divided equally between UP1 and UP2. If this option is 
deactivated, the UP1 to UP6 columns/input fields remain empty. 

  

Important! 

• Unit prices can only be allocated if you have added the 
UP_portions tab (for data sheets with tabs) or the UP1 to UP6 
columns (for data sheets without tabs) to the scheme you are 
using. 

• If you want to use the individual price portions not only for your 
own internal cost calculations in the Calculation phase, but also 
output them (e.g. in a file printout or to a GAEB file), you need to 
activate the "Unit price allocation" option for the items 
concerned. Only then will you be able to enter individual price 
portions for these items also later in subsequent phases 
(Quotation check, Awarding, etc.). 

• In addition, if you want the tenderers to quote the price portions 
in a tender based on GAEB guidelines, the "Unit price allocation 
is requested" option has to be activated for the entire file. 
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Assigning Additional Fees/Deductions 
You have copied prices from the master data to a new file. When 
performing cost calculations, you can now also assign additional 
fees or deductions as a percentage to the unit prices or total prices. 
The same applies for prices entered manually. 

  

Additional fees and/or deductions can be assigned not only to entire 
files but also to individual titles or items. In addition to individual 
prices, you can also update and thus change entire price columns. 

If you assign additional fees and/or deductions to individual items, 
Allplan Quantities immediately calculates the effective total prices of 
these items. The following applies: 

TP ± % +/- = TP eff. 

Total price ± additional fee/deduction = effective total price 

When you assign additional fees and/or deductions to entire levels in 
the hierarchy, Allplan Quantities initially enters the additional fees 
and/or deductions in the % +/- columns of all the subordinate data 
records. The effective total prices are only calculated when you 
trigger a new calculation of the entire file. 

  

 
 

Calculating Total Costs 
Before you can determine the estimated total costs of files or 
projects, you have to enter all the quantities and prices. Otherwise, 
the sums of the items and consequently the total sums cannot be 
calculated. 

When you (re-)calculate the total costs of a project, all the quantity 
lines are (re-)calculated and the results are entered in the Quantity 
columns of the relevant items. Next, these results are multiplied by 
the unit prices to get the total prices of the items. These total prices 
are finally summed up for every column. This is always done on the 
next superordinate level in the hierarchy. 
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When the (re-)calculation is complete, the results are entered in the 
Quantity, TP checked, TP eff., and TP grs columns in the item lines, 
total/end lines of the files and in the project’s cost line. 

Instead of calculating the entire project from scratch each time you 
change the quantities or unit prices, you can configure the program 
to automatically calculate the items’ sums. This can be specified in 
the user-definable settings. 

Important! 
When the Calculate the quantities immediately after entry option is 
enabled, only the sums of the item in question are calculated 
immediately. The total sums of the superordinate levels in the 
hierarchy – i.e. the titles, files and project costs – are only updated 
when you trigger a new calculation of the entire project. 
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DIN 276-Compliant Cost 
Calculation 

You can use the "DIN 276 – Cost group analysis" option to analyze 
and evaluate the costs of a construction project in compliance with 
the DIN 276 cost groups. 

ATTENTION! 
The "DIN 276 – Cost group analysis" option is an optional module. It 
does not come with Allplan Quantities. You need to purchase a 
license in order to use this module; otherwise, its functions are not 
available to you. 

  

Based on drafts that are to scale and qualitative building 
descriptions, cost calculations in compliance with DIN 276 are 
performed at the stage of designing. The level of detail you choose 
depends on the available cost data, amongst others. If detailed data 
is provided, you can even calculate the costs of individual tasks. The 
calculation of costs in compliance with DIN 276 is based on a 
project's files, including estimated prices and quantities. 

Items in files are sorted by trade (i.e. item number). When costs are 
calculated in compliance with DIN 276, Allplan Quantities basically 
only rearranges all the items in a project so that they are sorted by 
the entry in the DIN 276 column. All the hierarchies like file lines, 
title lines etc. are ignored. 

Allplan Quantities comes with a predefined project including the 
(new) DIN 276 cost classification, which is easy to install using the 
Archive Administration tool provided by Allplan Quantities. The tool 
copies the DIN 276 structure to the project directory. 

Allplan Quantities offers a special report – "Analyzing cost groups in 
compliance with DIN 276" – for printing DIN 276-compliant cost 
calculations. 
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Calculating costs in compliance with DIN 276 involves only a few 
steps: 

• Install the DIN 276 cost classification, 

• open the Calculation data sheet, and 

• print the DIN 276-compliant cost calculation. 

  

To make sure that everything runs smoothly, please keep the 
following in mind when creating the file: 

• The level of detail increases the more files are available in a 
project. 

• The items in the files must include the DIN 276 cost group 
numbers in the DIN 276 column. 
 
The cost group number of an item can consist of a maximum of 
nine digits plus one character (e.g. an underscore or the value 
"0") which is defined as an additional sorting criterion and which 
has to appear after the last digit. For example, the cost group 
numbers of items which are to be subordinate to cost group 331 
can be "331_" or "3310".   

• Estimated prices must be entered in the UP column and quantities 
in the Quantity column. 
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Exchanging Data via the 
GAEB Interface 

Different software systems impose ever-increasing demands on data 
exchange. As a result, there has been a call for a standardized format, 
which simplifies the process of exchanging data used for tendering 
(contractual agreements, text, quantities, prices). 

In November 1985, the first version of a standardized exchange 
format was introduced by the German committee for electronics in 
the construction industry (= GAEB). This standard was revised in 
June 1990 and in January 1997. Today the GAEB XML-format is 
commonly used. 

Allplan Quantities’ GAEB interface is based on the standard specified 
by the German committee for electronics in the construction industry. 
This standard controls the exchange of data between tendering and 
costing applications of different providers. 

  

This chapter provides detailed information on all the questions 
pertaining to the GAEB interface. In addition, you will learn about 
everything related to the exchange of data in GAEB format. In 
particular, this chapter shows how to 

• create files in compliance with the GAEB guidelines, 

• assign item categories in a GAEB-compliant manner, 

• set up files in compliance with the GAEB guidelines (see "Setting 
up Files in Compliance with GAEB Guidelines" on page 107), 

• add comments and technical contract conditions, 

• enter additional information on files (on page 126), 

• export data via the GAEB interface and 

• import data via the GAEB interface. 
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Special Feature Relevant to Exchanging 
Data via GAEB 90 

Files in GAEB 90 format are pure text files in ASCII format. 
Consequently, it can happen that Windows formatting applied to 
text (tabs, for example) is lost. 

 

 
 

Data Exchange Phases in Compliance with 
GAEB 

In compliance with GAEB the process of exchanging data consists of 
six phases (also referred to as "data types"), which are defined as 
follows: 

Data type Phase 

DA 81 Transfer of file: exchange of specification 
descriptions without prices 

DA 82 Transfer of estimated costs: exchange between 
client – architect – engineer during the design 
process 

DA 83 Invitation to tender: transfer of file to tenderer 

DA 84 Submission of quotation: transfer of quotation 
(including prices, quantities etc.) from tenderer 
to architect 

DA 85 Additional quotation: transfer of alternative 
data in addition to the main quotation 

DA 86 Awarding: transfer of file including the checked 
tender data to the tenderer who is awarded the 
contract (contractor) 
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The following illustrates the relationship between the phases: 

Client    Contractor 

 
Engineer 

    

 
    

Transfer of file: 
DA 81 / DA 82 

  or   

    

 
    

 

Architect 

 Invitation  
to tender: 

DA 83 

  or   

 
 

Tenderer 

 

 

    Preparation of 
quotation 

 

     

 

Architect 

 

 

 Submission of 
quotation: 

DA 84 

  or   

 

 
 

Tenderer 

Quotation 
check 

 

        

     

 

Architect 

 Awarding: 
DA 86 

  or   

 
 

Contractor 
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Creating Files in Compliance with GAEB 
Guidelines 

Allplan Quantities allows you to customize the structure of your 
projects to suit your own needs and requirements. But there are other 
applications used for tendering, ordering and billing that cannot 
process these structures. 

If you want to transfer data to other applications via the GAEB 
interface, it is worth spending some time planning a project’s 
structure before even making the first entry to ensure that the 
destination program can interpret the selected structure. 

  

Special attention should be paid to the following issues: 

• Files must be structured in compliance with GAEB. 

• Some applications used for tendering, ordering and billing can 
process two hierarchical levels maximum. 

• All the items must be on the same level in the hierarchy. 

• Files must be set up in compliance with GAEB. 

• Additional information on files must be entered correctly. 

  

If you do not know which settings can be processed by the 
destination program, you should structure projects based on the 
guidelines given below. The project suggested is structured in 
compliance with GAEB and can be read by all applications used for 
tendering, ordering and billing that have a certified GAEB interface. 

Note: These are only suggestions – try out different options yourself! 
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Structuring Files in Compliance with GAEB Guidelines 

The process of exchanging data using the GAEB format is based on 
file structures. This means that individual files and text are transferred 
rather than entire projects. It is therefore important that you create at 
least one file line in projects you want to transfer via the GAEB 
interface. 

A file structure might look like this: 

 
 
 

Assigning Categories and Types of Items in Compliance with GAEB 
Guidelines 

The following item categories can be used without restrictions in 
GAEB-compliant files: 

• Normal item, 

• Basic item, 

• Alternative item, 

• Requirement item, 

• Contingency item, 

• Inapplicable item 
and 

• Work for hourly wage. 
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Similarly, you can use the following item types without restrictions: 

• Normal item, 

• Main description, 

• Sub-description, 

• Start of execution description  
and 

• Block of execution description. 

  

Please pay careful attention to the following special features: 

• Do not use the item categories TextComment or TextItem within 
files; use the Comment data record type only! The TextComment 
and TextItem item categories are used exclusively for pure "text 
files" (e.g."comments and technical contract conditions"). 

• Requirement and contingency items are mutually exclusive in 
files. 

• When data is exchanged based on DA 82, items without total 
quantities must not be exported (i.e. no alternative or 
contingency items). Basic items are treated as normal items. 
Tenderer quantities must be specified as estimated quantities. 

  

In addition, the basic rules for defining item categories and types 
apply. 

Note: For a detailed description of item categories and types, please 
see the section entitled "Defining Item Categories and Item Types" in 
the "Tendering" chapter. 

  

 
 

Setting up Files in Compliance with GAEB Guidelines 

Files you want to exchange via the GAEB interface have to be set up 
in compliance with GAEB guidelines. The "Set up files in GAEB 
format" feature lets you set up files quickly and easily. 
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Allplan Quantities automatically creates a key for ordinal numbering 
(= ON key), which you can accept or modify (even at a later stage). 
Based on the format of this ON key, Allplan Quantities then sets up 
the entire file in ascending order. 

  

The ON key, which consists of a maximum of nine digits, defines the 
format of the item numbers to be assigned. The characters of the ON 
key represent the number of digits for the individual levels in the 
hierarchy, the items and the item index. 

For example, the "1122PPPPI" ON key creates the following item 
number: "01.22.  12a". "01" is the number of the first title in the 
hierarchy, "22" is the number of the second title, "  12" is the item 
number and "a" the item index. 

Note: The item index is not used in Allplan Quantities. 

The result might look like this: 

 
  

Important! 
Comments and the ‘Sub-description’ and ‘Execution description’ item 
categories are not set up automatically. You can use the "Change 
item category" tool to assign consecutive numbers to these item 
categories when defining them. 
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GAEB-Compliant Units of Quantity 

Allplan Quantities checks the entered quantity units to verify that 
they are commonly used and comply with the notation according to 
STLB-Bau. If you use a different quantity unit or notation/spelling, 
Allplan Quantities indicates this when checking the file for 
compliance with GAEB guidelines (cf. "Checking Files (see "Checking 
Files" on page 126)"). This does not mean that your entry is 
incorrect, but rather that you may need to clarify the quantity unit 
with the persons you will be exchanging the data with. 

Important! 
Units of quantity can consist of a maximum of four characters. 

The following units of quantity are commonly used in GAEB-
compliant files: 

Unit Meaning 

d Day 

dam3 Cubic decameter (1000m³) 

h Hour 

Jr Year 

kg Kilogram 

km Kilometer 

km2 Square kilometer 

l Liter 

m Meter 

m2 or m² Square meter 

m3 or m³ Cubic meter 

Mt Month 

psch Lump sum 

St Piece 

t Ton 

Wo Week 

md Meters x days 

mWo Meters x weeks 
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mMt Meters x months 

m2d Square meters x days 

m2Wo Square meters x weeks 

m2Mt Square meters x months 

m3d Cubic meters x days 

m3Wo Cubic meters x weeks 

m3Mt Cubic meters x months 

m3km Cubic meters x kilometers 

Sth Pieces x hours 

Std Pieces x days 

StWo Pieces x weeks 

StMt Pieces x months 

St/M Pieces per month 

St/J Pieces per year 

tMt Tons x months 

  

 
 

Comments and Technical Contract Conditions 

You can also exchange comments and additional contractual 
agreements (e.g. technical contract conditions) via the GAEB 90 
interface. All you need to do is integrate them as text files in GAEB 
files before and/or after the file they are associated with. 

Allplan Quantities generates the term "Start of contractual 
agreement" for every text line and text comment line. Similarly, 
"Text of contractual agreement" is assigned to long text entered in 
text windows using memo fields. Consequently, the text sum line is 
the "End of contractual agreement". 
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The result might look like this: 

 
  

 
 

Additional Information on Files 

Additional information on files (such as "information on the project" 
or "information on the client") cannot be displayed directly in the 
file structure. 

You can use the Properties of (name of file) dialog box to enter 
additional information in an easy and comfortable manner, thus 
avoiding wrong entries. 

Note: You can enter additional information for each file even when 
a project consisting of several files is to be exported in its entirety. 

  

 
 

Checking Files 

Before you export files via the GAEB interface, you should check 
that these files actually meet the requirements imposed by the GAEB 
guidelines. 
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A log indicates whether errors have been detected. You might see the 
following messages: 

• When this message is displayed, the file complies with the GAEB 
guidelines and can be exported. 

 

• When this message appears, the file contains errors. Correct the 
error causes indicated in the log and check the file again. 

 

  

 
 

Exporting Files to GAEB Files 
There are two ways to export files to GAEB files: 

• You can export a single file to a GAEB-format file by placing the 
insertion marker in the file line of the relevant file before you 
start the export. 

• You can export several files (e.g. file with text file) to a GAEB-
format file by placing the insertion marker in the folder/project 
line of the level in the hierarchy that is superordinate to the 
relevant files. 

Note: When exporting files with contractual agreements (= file with 
text file), make sure that the insertion marker is positioned correctly: 
to export a file including contractual agreements to a GAEB-format 
file in a single step, you need to place the insertion marker in the 
superordinate folder/project line. To add a file (e.g. a text file) to a 
file that has already been exported to a GAEB file, you need to 
position the insertion marker in the relevant file line. 
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Options for GAEB export 

Advanced settings are available for exporting data to GAEB-format 
files. You can use the GAEB Options tab in the Properties of (name 
of file) dialog box to make these settings, which can vary depending 
on the GAEB phase. 

Allplan Quantities provides a number of special settings for exporting 
data to GAEB 90-format files. 

  

 
 

Importing GAEB Files 
GAEB-format files can be imported into Allplan Quantities via the 
GAEB interface. Imported files can be inserted in existing projects or 
in new projects you create during import. 

Note: To import prices from proposals in DA 84 format, you have to 
take into account the special features that are described in the section 
that follows. 

  

 
 

Importing Prices from DA 84-Format Files 
GAEB-format files of data type 84 (= proposal delivery) contain 
additional data that is created by tenderers only. Consequently, when 
you import GAEB files in the DA 84 format, Allplan Quantities does 
not create a complete structure. Rather, the data (prices, quantities, 
additional text etc.) the tenderer has entered in the GAEB file is 
added to the existing file structure (= file in an existing project). 

Before the GAEB data is actually imported, Allplan Quantities scans 
the current project for the file in the GAEB file. The search criterion 
is the short text of the file. When the file is found in the project 
(otherwise, the GAEB data is not imported correctly), Allplan 
Quantities displays all the tenderers created for this file. The data in 
the GAEB file can then be copied to an existing or new tenderer. 
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If Allplan Quantities does not find the file (in this case, the file has 
changed in the meantime), you can select a file to which the prices 
are to be copied. 

During import, Allplan Quantities checks that the data (i.e. item 
numbers, item categories, prices, quantities, additional text etc.) is 
consistent and complete. If errors are detected, a log is generated. In 
this case, the file has changed in the meantime. Consequently, the 
proposal is invalid! 
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Printing Cost and Quantity 
Calculations 

In particular, project-specific data sheets include large volumes of 
data of different types. To generate printouts of overviews, cost 
calculations or quantity calculations etc., Allplan Quantities only 
requires certain types of data from the respective data sheet; these 
should be clearly arranged on the printout. To accomplish this, 
reports (= print templates) are provided which serve as the basis for 
every printout. 

  

Using these reports, you can specify 

• which data of a data sheet is to be printed out, 

• which additional text (e.g. headings, list headers, footers) and 
images (e.g. logos) are to be included in printouts and 

• what layout the printout should have. 

Various predefined reports are available for each data sheet. For 
example, you can create printouts of files based on various layouts 
as well as print cost calculations with or without quantity 
calculations from within the Calculation data sheet. 

  

Allplan Quantities provides such a wide choice of reports with a vast number 
of details that it is hard to remember everything. To make thing easier, you 
can look up the most important information on each report directly in the 
Info tab of the Print dialog box. 
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Printing is easy. All you do is: 

• Define the contents of the printout and select the data you want 
to print. For example, place the insertion marker in the data line 
where printing is to start and display the data records to be 
printed. 

• Then open the Print dialog box. 

• If required, change the layout template in the Output tab and set 
other report options. 

• Set up the printer and start printing. 

Note: You can use the report designer to modify and customize 
reports or to create new reports. How this is done is described in 
detail in the "Editing reports" section. 

  

 
 

Defining the Contents of the Printout and 
Preselecting Data 

Allplan Quantities always prints the data of the open and active data 
sheet. In addition, printouts always include 

• the data line where the insertion marker is located and 

• all data lines that are hierarchically subordinate to this data line. 

Thus, the contents of the printout is always defined by the position 
of the insertion marker in the data sheet before you open Print  
dialog box. Allplan Quantities initially assembles the printout based 
on the data line in which you have currently placed the insertion 
marker and all data records that are hierarchically subordinate to 
this line. For printing, it is important whether or not the subordinate 
data records are visible. Only the visible data records will be printed. 

If you have selected subordinate records, only the selected records 
will be printed. In this case, it does not matter whether or not these 
data records are visible. 
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Open the "Print" Dialog Box and Select Print 
Settings 

After you have defined the contents of the printout and selected the 
data, open the Print dialog box. 

This dialog box usually displays all reports for selection that are 
available for the active data sheet. To make it more convenient for 
you to find the desired report, the reports are grouped. You can also 
create your own report groups, e.g. for frequently used reports or for 
user-defined reports. 

In the Output tab of the Print dialog box, you can select the print 
settings to be used for the current printout. Click the "More options" 
button to display general print settings. 

  

 

Selecting Advanced Print Settings 
Before printing your files, you can define some advanced print settings 
using a layout template. This includes the footer text to be printed and 
the logo you want to integrate in the printout. 

You can define the following defaults in the Print tab of the Settings 
dialog box: 

• change footer text that is to be printed at the bottom of each 
page (e.g. your office contact data), 

• add your company logo, 

• create your own layout templates or   

• set the directory where the currently required reports are stored 
(this means that it is possible to change the current report path 
without exiting the Print dialog box). 

ATTENTION! 
These settings will be valid for all reports that come with Allplan 
Quantities and can only be changed in the way described here. 
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Checking Printouts in the Preview 
Before you start printing, you can open the Preview dialog box and 
review the printout you prepared. The pages can be displayed in two 
different modes: whole page or zoomed in. 

Note: If you open a print job instead of a single report in the 
preview, you need to close the preview for each report included in 
the print job (example: a print job contains 4 reports -> you need to 
close the preview 4 times). 
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Analyzing and Evaluating 
Quantity Takeoff Schedules 

Basic functions using standard tools 

You can use all the basic functions provided in Allplan Quantities to 
analyze and evaluate imported CAD data. 

Graphical price comparison lists and reports in particular facilitate 
the procedure of analyzing and evaluating objects designed using 
Allplan at any stage. 

  

Special functions 

Besides the standard tools, Allplan Quantities provides special reports 
for analyzing and evaluating files and element schedules that have 
been created based on CAD data. 

When you install Allplan Quantities, these reports are usually stored 
in the directory ...Data\Nemetschek\Allbase\Daten\ 
Berichte\Extended.V2014. If you will be using these reports 
regularly, set the default report path to this directory. 

  

 

Tip: You will find an overview 
of the most important 
information on each report in 
the Info tab of the Print 
dialog box. 
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Editing Reports 
The report designer provides a convenient way of editing reports. 

  

This chapter provides detailed information on the following topics: 

• The report designer in general and how to open this tool 

• Creating and modifying reports 

• Customizing reports 

• Adding fields and defining variables 

• Defining conditions for printing objects 

• Defining specific controls for reports 

• Exporting/backing up and restoring reports 

  

 
 

What is the Report Designer? 
Reports are used to specify what is to be printed out and how: 
Reports define the design, contents and graphical appearance of 
printouts as well as the objects, text and fonts in printouts. 

In other words, the report designer is a comfortable tool you can use 
to define the form and contents of reports and consequently of 
printouts. You can modify existing reports or create new reports. 

  

The sections that follow provide detailed information on 

• the layout window of the report designer, 

• the tools in the report designer and 

• the toolbars in the report designer. 
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Layout Window of the Report Designer 

When you open the report designer, the program automatically displays 
the layout window and the Report Designer and Report Controls 
toolbars (to show the other two toolbars, click the  Layout and  

 Color Palette icons on the Report Designer toolbar). 

 

To edit the printout templates, you can use the File, Edit, Format and 
Report menus and the toolbars (cf. sections entitled "Tools in the report 
designer" and "Toolbars in the report designer"). 

You can use the layout window to insert objects (text, fields, lines, 
rectangles, images etc.) in reports or edit existing objects. The file 
name of the report is displayed in the title bar of the layout window. 

The layout window itself shows the individual sections of a report 
and the objects in these sections. You can quickly and easily define 
the size of sections - all you need to do is position the cursor on the 
bar with the section name displayed at the bottom of each section so 
that the cursor becomes a double-headed arrow. Now press and hold 
the left mouse button and drag to change the size. 
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Note: The field names are displayed in the layout window of the 
report designer. The print preview and the final printout include the 
actual data from the data sheet. 

Reports consist of individual sections, which are separated by bars. 
All these sections together define the printable area of the paper.  

Each section, which is delimited by a bottom bar displaying the 
name of the section, can include objects. The sections are described 
in the table below. 

Section Meaning 

Page header The page header appears at the top of every 
page. Besides predefined information (e.g. 
heading and list heads), it also includes variable 
data (e.g. number of pages and date). 

Detail The detail section contains the fields that are 
associated with the data in the data sheets. This 
section is printed out for every data record. 

Page footer The page footer appears at the bottom of every 
page. In addition to text, the footer can also 
include variable data (e.g. number of pages and 
date). 

Group header/footer Group header and group footer are only 
available when data has been grouped by 
common characteristics and contain information 
that is only relevant to the data group in 
question. The group footer may include a sub-
total, for example. 

Optional Bands The report title and report summary are defined 
separately and appear at the beginning and/or 
end of a printout (e.g. cover sheet and/or final 
note) or on separate pages (optional). 
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Tools in the Report Designer 

The tools needed for editing layout templates are provided on the 
File, Format and Report menus and on the standard Windows Edit 
menu (not described here). 

 
 

Tools on the "File" Menu (report designer) 

You can use the tools on the File menu to save modified or new 
reports, discard your most recent changes and define the page 
layout. 

  

Tool Use 

Save  You can use this tool to save the changes you 
made to a report. 

Save As HTML You can use this tool to save reports in HTML 
format. 

Revert You can use this tool to discard the changes 
you have made to a report. You can go back 
(undo) as many steps as you want, as far back 
as the last time the report was saved. 

Page Setup You can use this tool to define the page layout 
of a report. 

Print You can use this tool to print out reports for 
checking purposes. 

 
 

Tools on the "Format" Menu 

The Format menu includes tools you can use to edit objects in 
reports. 

These tools can only be applied when at least one object is selected. 

Tool Use 

Align You can use this tool to align selected objects. 
Choose one of the options provided on the 
submenu. 
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Tool Use 

Size You can use this tool to modify the size of 
selected objects. Choose one of the options 
provided on the submenu. 

Horizontal Spacing You can use this tool to modify the horizontal 
spacing of selected objects. 

Vertical Spacing You can use this tool to modify the vertical 
spacing of selected objects. 

Bring to Front You can use this tool to move the selected 
objects to the front. 

Send to Back You can use this tool to move the selected 
objects to the back. 

Group You can use this tool to group selected objects. 

Ungroup You can use this tool to explode the selected 
object group into its constituent objects. 

Snap to Grid You can use this tool to place objects so that 
they are aligned with the grid for snapping 
points (option enabled). Alternatively, you can 
place them freely (option disabled). 

Set Grid Scale  You can use this tool to set parameters for the 
point snap grid. 

Font You can use this tool to define the font or font 
size for selected text objects. 

Foreground Color You can use this tool to define the pen color for 
selected text or drawing objects. 

Background Color You can use this tool to define the background 
color or fill color for selected drawing objects. 

Text Alignment You can use this tool to specify whether the selec-
ted text objects are left-aligned, right-aligned or 
centered or define the spacing between lines. 

Fill You can use this tool to apply hatching styles 
or fills to rectangles and rectangles with 
rounded corners. 

Pen You can use this tool to define the linetype and 
line width for selected lines, rectangles and 
rectangles with rounded corners. 

Backstyle You can use this tool to specify whether 
selected objects are fully opaque or transparent. 
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Tools on the "Report" Menu 

The Report menu contains tools for creating new objects or reports. 

  

Tool Use 

Quick Report You can use this tool to insert all necessary fields 
in a new report. This tool is only available when 
the detail section is empty. 

Run Report You can use this tool to print out the report as 
currently set for checking purposes. You do not 
need to save it. 

Print Preview You can use this tool to show the report in print 
preview 

Load Data Environment You can use this tool to define the data 
environment; however, this is not necessary for 
Allplan BCM. 

Private Data Session You can use this tool to activate database 
functionality that is not supported by Allplan 
Quantities. This option should always be disabled. 

Printer Environment You can use this tool to activate database 
functionality that is not supported by Allplan 
Quantities. This option should always be disabled. 

Optional Bands You can use this tool to insert the "report title" 
and/or "report summary" sections. 

Data Grouping You can use this tool to group selected objects. 

Variables You can use this tool to define variables for 
reports. 

Default Font You can use this tool to make default settings for 
the font and font size, which are to be used for 
new text objects. 

Edit Bands You can use this tool to select individual sections 
whose parameters you want to edit. 

Insert Control You can use this tool to insert control elements. 

Properties You can use this tool to set the paper size, page 
layout and default font. 
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Toolbars in the Report Designer 

The report designer features four toolbars for quick access to 
frequently used tools: the Report Designer, Report Controls, Color 
Palette and Layout toolbars. 

They provide easy-to-use tools for editing reports. 

  

 
 

Buttons in the "Report Designer" Toolbar 

When you click one of the buttons, the program selects the relevant 
tool or displays an additional toolbar. 

 

Icon Function Use 

 Data Grouping You can use this tool to group selected objects. 

 Data environment You can use this tool to define the data 
environment, which is not necessary for Allplan 
Quantities. 

 Page setup You can use this tool to set the paper size, page 
layout and default font. 

 Report controls You can use this tool to show and hide the 
Report Controls toolbar (see "Buttons in the 
"Report Controls" Toolbar" on page 143). 

 Color palette You can use this tool to show and hide the Color 
Palette toolbar (see "Buttons in the "Color 
Palette" Toolbar" on page 144). 

 Layout You can use this tool to show and hide the 
Layout toolbar (see "Buttons in the "Layout" 
Toolbar" on page 145). 
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Buttons in the "Report Controls" Toolbar 

 

  

When you activate a tool on the Report Controls toolbar by clicking 
a button, the program executes the relevant function and then 
automatically displays the  marker again. 

Note: However, you can also "fix" tools: double-click to select a tool 
or select a tool and then click  Repeat control element. 

Icon Function Use 

 Marker You can use this tool to select objects. 

 Text tool You can use this tool to enter or modify text (see 
"Inserting Text Objects" on page 152). 

 Field tool  You can use this tool to insert fields. 

 Line tool  You can use this tool to insert horizontal or 
vertical lines. 

 Tool for rectangles  You can use this tool to insert rectangles. 

 Tool for rectangles 
with rounded corners  

You can use this tool to insert rectangles with 
rounded corners. 

 Tool for OLE objects You can use this tool to insert OLE objects 
(images and sketches) (see "Insert Images and 
Sketches" on page 153). 

 Repeat control element You can use this tool to fix the active tool and 
insert several objects of the same type. 

 
 

Buttons in the "Color Palette" Toolbar 
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Icon Function Use 

 Foreground color You can use this tool to define the foreground 
color for objects. 

 Background color You can use this tool to define the background 
color or fill color for objects. 

 Other colors You can use this tool to open a dialog box in 
which more colors are presented for selection. 

   

 
 

Buttons in the "Layout" Toolbar 

 

Icon Function Use 

 Align left sides You can use this tool to align the selected 
objects left. 

 Align right sides You can use this tool to align the selected 
objects right. 

 Align top edges You can use this tool to align the selected 
objects so that their top edges are flush. 

 Align bottom edges You can use this tool to align the selected 
objects so that their bottom edges are flush. 

 Align vertical centers You can use this tool to align the selected 
objects so that their vertical axes are centered. 

 Align horizontal 
centers 

You can use this tool to align the selected 
objects so that their horizontal axes are centered. 

 Same width You can use this tool to assign the same width to 
the selected objects. 

 Same height You can use this tool to assign the same height 
to the selected objects. 

 Same size You can use this tool to assign the same size to 
the selected objects. 
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Icon Function Use 

 Center horizontally You can use this tool to horizontally center the 
selected object. When you select several objects, 
they are centered as a group. 

 Center vertically You can use this tool to vertically center the 
selected object. When you select several objects, 
they are centered as a group. 

 Bring to front You can use this tool to move the selected 
objects to the front. 

 Send to back You can use this tool to move the selected 
objects to the back. 

 
 
 

Creating and Modifying Reports 
The form and contents of printouts can be modified in different ways: 

• You can copy an existing report and then modify this copy. The 
original report is not affected by this operation. 

Important! 
This procedure must be used for all original Allplan BCM reports 
because these reports cannot be modified! 

• You can modify an existing report directly. 

Important! 
This approach is only available with your own reports and copies 
of the original reports! 

• You can create a new report. 
 

Copying a report 

If an existing report is more or less sufficient for the task at hand 
and you only need to make minor changes, you can simply copy the 
relevant report and modify the copy. 

Important! 
This procedure must be used for all standard reports provided by 
Allplan Quantities in order to keep the originals. 
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Modifying an existing report 

To modify an existing report, open the relevant report in the report 
designer, make changes and save the modified report. 

Note: To change the original Allplan BCM reports, you need to copy 
them first and then modify the copies. 

Creating a new report 
 
To create custom reports, it is best to start from scratch. 

In other words, create a new report and adapt it to your needs and 
requirements. 
 
 
 

Customizing Reports 
The report designer offers various options for defining the graphical 
appearance of printouts. In particular, you can 

• Define the page layout 

• Add a report title and report summary 

• Specify the height of the individual sections 

• Select, group and position objects and change their size 

• Enter and format text (e.g. headings or list heads) 

• Enhance the visual appearance by adding graphical elements (e.g. 
colored lines and rectangles) or images (e.g. logos) 

  

The quickest way to design a report is to insert all text lines, images, 
lines and rectangles, select all the objects to be edited in the same 
way (e.g. select all the text lines to give them a uniform appearance 
by assigning the same font and size) and make changes. 

Note: You can check the graphical appearance of printouts on 
screen. Click the right mouse button and select Preview on the 
shortcut menu. This preview shows all the data records of the data 
sheet, regardless of the insertion marker’s position in the data sheet 
and the selected data records. 
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Object Types of Reports 

Reports can include different types of objects, which are described in 
the table below. 

Object type Function 

Text object Text that is not included in data sheets is inserted 
as text objects in reports (see "Inserting Text 
Objects (on page 152)"). 

Field object Field objects are associated with the columns of 
the data sheet to which the report is assigned (cf. 
"Using Fields and Variables"). 

Drawing object Linear and rectangular objects can be used to 
enhance the graphical appearance of reports (cf. 
"Adding Graphical Elements"). 

OLE object Objects from other Windows applications can be 
integrated as files or links in reports (cf. "Inserting 
Images and Sketches (see "Insert Images and 
Sketches" on page 153)"). 

You can define conditions for every individual object or for entire 
groups of objects, which are taken into account when printing. 

 
 

Define the Page Layout for Reports 

You can define the page setup of reports. In other words, you can 
specify how sections and objects are arranged in printouts. 

  

To define the page layout 

 The layout window of the report designer is open. 

1 Click Page setup on the File menu. 

The Report Properties dialog box appears. 

2 Select the Page Layout tab and make the necessary settings. 

Note: You can change the unit of measurement in the Ruler & 
Grid tab (e.g. from "cm" to "pixels"). 

3 Click OK. 
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Add or Remove a Report Title and Report Summary 

Report titles and summaries are independent sections that are 
defined separately. The objects in these two sections always print out 
just once: The report title appears at the beginning of a printout and 
the report summary at its end. 

This way, you can add a cover sheet and/or final note to a file. It is 
even possible to display the title and summary on separate pages. 

  

To add a report title or summary 

 The layout window of the report designer is open. 

1 Click Optional Bands on the Report menu. 

The Report Properties dialog box appears. 

2 Select the Optional Bands tab and activate the Report has title 
band option and/or the Report has summary band option. 

3 Choose the other options, as required. 

4 Click OK. 

  

To remove a report title or summary 

 The layout window of the report designer is open. 

1 Click Optional Bands on the Report menu. 

The Report Properties dialog box appears. 

2 Select the Optional Bands tab and deactivate the Report has title 
band option and/or the Report has summary band option. 

3 Click OK. 
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Specify the Height of Sections in Reports 

You can enter any height for the individual sections. However, check 
that the final printout (= all sections) does not exceed the printable 
area of the paper. 

You can specify a minimum height or set a fixed value for the 
height. When you enter a minimum height for a section, please make 
sure that all objects actually fit in the relevant section. 

  

To specify the height for a section 

 The layout window of the report designer is open. 

• Drag the bar that delimits the section to the required height. 

Or: 

1 Double-click the bar delimiting the relevant section. 

The ... Band Properties dialog box appears. 

2 Select the General tab and enter the height. 

Note: You can change the unit of measurement in the Ruler & 
Grid tab (e.g. from "cm" to "pixels"). 

3 Activate the Constant band height option if you do not want the 
section to be resized automatically (e.g. when adding data or 
deleting empty lines). This is necessary e.g. when printing reports 
on labels. 

4 Define an expression for the section, if required, by clicking  
next to On entry or On exit under Run expression. 

Detailed information is provided in the section entitled "Define 
Expressions". 

5 Click OK. 
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Selecting Objects in Reports 

Use the  Marker on the Report Controls toolbar (see "Buttons in 
the "Report Controls" Toolbar" on page 143) to select objects (see 
"Object Types of Reports"). 

The selected objects (any combination possible) can be addressed as 
a single entity for easy manipulation. You can use the Cut, Copy, Paste 
and Delete tools as you would in any other Windows application. 

Selected objects can be grouped, moved and superimposed. In addition, 
you can change the size of objects (not available with text objects). 
Rulers and grids assist you in the process of positioning objects. 

  

 
 

Grouping Objects 

You can combine several objects (see "Object Types of Reports") in a 
group that can be selected, cut, copied, deleted, pasted and moved as 
a single entity. For example, text and lines of a header can be combined 
in a group and placed as a whole. 

Object groups facilitate the process of positioning objects. As opposed 
to data groups (consisting of fields and variables), however, object 
groups have no effects on printouts.  

  

 
 

Positioning and Resizing Objects 

Rulers and grids provide additional support as you position objects 
(see "Object Types of Reports") or change their size. The spacing 
between the lines of the ruler and a unit of measurement can be set 
in the Ruler & Grid tab of the Report Properties dialog box. 

You can activate or deactivate the grid using the Snap to Grid tool 
on the Format menu. 

You can define the size of field objects, drawing objects and OLE 
objects as you need. The size of text objects, on the other hand, is 
determined automatically and depends on the text length, font and 
font size. 
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Inserting Text Objects 

Use the  text tool in the Report Controls toolbar (see "Buttons in 
the "Report Controls" Toolbar" on page 143) to create fixed text and 
labels. You can set the  Text tool to active with  Repeat control 
element to create a number of text objects in succession. 

New text objects are always inserted using the formatting (font and 
font size) you have defined in the layout settings as the default font 
for the report (see "Defining the Page Layout for Reports (see "Define 
the Page Layout for Reports" on page 148)"); you can change these 
defaults at any time. 

You can of course also modify the formatting of existing text objects 
any time you like. In addition, you can apply the same font to all the 
objects in a report in a single step; this also includes all text objects 
in the report (see "Designing Typography and Typesetting (on page 
152)"). 

  

 
 

Designing Typography and Typesetting 

The report designer provides many features with which you can 
freely design the typography and typesetting of text objects and 
fields containing text and numbers, as far as supported by your 
operating system. 

Each object you newly add to a report is automatically formatted 
according to the font and font size you have defined as the default 
font in the layout settings for the report (see "Defining the Page 
Layout for Reports (see "Define the Page Layout for Reports" on page 
148)"). You can modify this formatting any time later using one of 
the methods described below. 

You can also freely place objects and choose if you want a fixed 
offset to the top or bottom of the section (see "Positioning and 
Resizing Objects"). The "Fix relative to top of band" setting is the 
default. 
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Adding Graphical Elements 

You can enhance printouts by adding lines and color areas. The 
report designer provides a number of options. In particular, you can 

• Insert vertical and horizontal lines 

• Add rectangles, rectangles with rounded corners, circles and 
ellipses as frames or color areas 

• Apply color areas or hatching styles to objects (e.g. text) 

Note: On black/white printers, these areas will appear as gray tones. 

  

 
 

Insert Images and Sketches 

You can either insert images and sketches directly in your report 
(e.g. add your company logo to the page header) or load them into 
the printout from fields in the relevant data sheet columns (e.g. 
implementation sketches for items). 

 

 

Using Fields and Variables 
"Fields" are used to integrate the data in the columns of the data 
sheets in printouts. When printing, Allplan BCM processes all the 
data records one after the other. The data in the fields is checked and 
the results are listed in the printout. 

Fields can even be calculated or include variables. "Variables" are 
used to save values or calculation results. Besides predefined 
variables, you can define further variables for each report. Functions 
are used to link fields and variables. 

You can also group this data. This way, you can print out each 
group (title with items) on a new page, for example. 
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Field types and variable types 

Field/variable types describe the type of data to be output. The type 
is given in the list boxes in the Output window. 

ID of type Data type 

C Alpha-numeric (field length limited to 254 
characters) 

D Date 

F Floating point number 

G Object 

L Logical 

M Alpha-numeric (memo fields of unlimited length) 

N Numeric 

Fields in data sheets 

A field is available for each column in the data sheets. In addition, 
there are some fields that are used to classify data more precisely. 
You will find a list of the most important fields and their properties 
in the online help under "Fields in Data Sheets". Please note that 
fields Allplan BCM uses only internally are not listed here. 

 

Defining variables 

Variables are used to save values or calculation results. Variables can 
be defined as fields in reports or as parts of expressions. They are 
available in the Variables list box in the Expression Builder dialog 
box. However, they can only be used for the report for which they 
have been defined. The reports that come with Allplan BCM also 
include variables, the page number, for example.  

Variables can also be integrated in calculations. The program starts 
with the initial value and the result is saved in the variable. 
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Predefined Allplan BCM variables 

You can use the variables listed below in expressions for executing 
reports and in initialization/finalization procedures. 

Name of 
variable 

Data type Use 

_ZV_SEITE Numeric Page number at which to start printing. 

This variable contains the value of the First page 
data entry box of the Report manager dialog 
box. 

_ZV_LOGO Numeric 1 = the Print logo option is enabled. 

0 = the Print logo option is disabled. 

_ZLGO.BR_LOGO Object Image object of logo. 

_ZV_FUSS1 

_ZV_FUSS2 

Character Variables for the text that appears in the footer. 
You can enter this text when you click the More 
options button in the report manager. 

_ZV_DATE Date Date specified in printouts. 

This variable contains the value of the Date data 
entry box of the Report manager dialog box. 

   

The most important functions 

Functions are used to link fields and variables. The table below only 
lists the functions that are used in reports. 

Note: More functions available in Allplan Quantities are described 
under "The most important functions" in the online help. 

Function Meaning 

evaluate(var) Ensures that a report can be used for all data 
sheets. The value in the open data sheet is 
always used. 

Character functions  

"Text" Compares character by character. 

ALLTRIM(expC) Removes blanks from character strings. 
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Logical functions  

= Boolean operator: "equal" 

NOT or ! Logical negation (the expression is true if the 
following value is not true). 

AND Boolean operator: "and" (the expression is true 
if both values are true). 

OR Boolean operator: "or" (the expression is true if 
one of the two values is true). 

EMPTY(exp) Checks whether fields or variables are empty. 

IIF(,,) Function with syntax: "if condition, then....; else 
.....". If the condition is true, this function yields 
the "then" value. If the condition is not true, 
this function yields the "else" value. 

Date functions  

DATE() Returns the current system date. 

  

 

Inserting fields 

You can use the  Field tool to insert a single field in a report 
where you require. 

As an alternative, you can click the Quick Report tool to open the 
Quick Report dialog box. Here you can use tables to select several 
(or all) fields that exist for a data sheet. The selected fields are 
automatically placed in the detail section. 

Note: The Quick Report tool is only available when the default detail 
section in the report is empty and no further detail sections have 
been added. 

 

Defining expressions 

An expression consists of data sheet fields and/or variables that can 
be linked using various functions. The expression defined is applied 
to each data record you have selected. 
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You can specify expressions to 

• Define fields 

• Define conditions which are taken into account when objects are 
printed 

• Group data 

• Define variables (assigning initial values and values to store) 

Expressions are usually defined using the Expression Builder dialog 
box, which contains four list boxes you can use to select functions 
from various groups. The Expression for Field on Report field 
displays the selected functions, fields and variables. The expression 
could also be entered directly in this field; however, this should only 
be done by database experts. 

The Variables list box shows all the variables (including name and 
type) that have been defined for the current data sheet. For more 
information, see the "Defining variables" section above. 

 

Formatting fields 

The format defines how a value is displayed in printouts. Formatting 
typical of field data specifies that uppercase letters are used for all 
alphabetical characters, for example. 

 

Grouping data 

Grouping data means that data records are grouped based on a 
common feature. For example, you can print out each group on a 
new page and assign headers and footers to each group. Groups are 
changed when the value of the grouping condition changes. Groups 
can also be nested. 

 

Inserting images from fields 

Sketches you have added to projects (Image column) can be 
integrated in reports using a table field. 
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Defining Conditions for Printing Objects 
You can define conditions which are taken into account when 
objects are printed out. Conditions can be specified for each object. 
For example, you can define that short text is only printed for item 
lines.  

  

 
 

Specific Controls for Reports 
Reports can be controlled using a specific template. 

The initialization procedure for reports consists of two parts: 

• Part 1: Mask control 

• Part 2: Report control 

Note: When using print jobs, a few special notes need to be 
observed. 

  

 
 

Specific Mask Control 

The mask control is used to create dialog elements in the bottom half 
of the Output tab in the Print dialog box. The mask control is defined 
in the Initialization procedure dialog box and indicated in the 
following way: 

#MASK 
..... 
..... 
..... 
#ENDMASK 
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You can define up to six mask elements in this section. If more than 
six elements are specified, they are ignored. The elements created are 
immediately displayed in the Output tab of the Print dialog box. 

The most important functions for creating and controlling mask 
elements are described in the online help under "The most important 
functions". 

 
 

Specific Report Control 

The report control corresponds to the print feed feature known from 
versions earlier than V6.0. The report control is indicated in the print 
feed in the following way: 

#PROG 
..... 
..... 
..... 
#ENDPROG 

You can use the report control to make the proper configuration 
settings, check filter conditions etc. In addition, you can determine 
the specific settings made in the mask control, which can also be 
determined directly in the report, however. Reports created in 
previous versions of course can also be used without the specially 
indicated sections. 

The most important functions for controlling reports are described in 
the online help under "The most important functions". 

Important! 
The elements created are only effective for as long as the report is 
selected within the Print dialog box. When you switch to another 
report, the specific elements change accordingly. 
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Special Notes on Print Jobs 

In print jobs, feeds can be defined in two different ways: 

• Using the feeds of the individual reports 

• Using the feed of the print job 

  

Using the feeds of the individual reports 

The sections from #PROG to #ENDPROG in the individual reports are 
executed. 

If you want to use mask options, a #MASK  ....  #ENDMASK section 
must be added to the print job. In this section, you define the options 
for all subsequent reports. When creating a new print job, this section 
is created automatically based on all mask control sections of the 
individual print jobs. In most cases, however, you will need to edit 
this mask section manually. 
 

Example: 

The print job includes the following section: 

#MASK 
_PRMSK_CHECK("chk1","Print prices",0) 
_PRMSK_CHECK("chk2","Printout based on StLB",1) 
#ENDMASK 

For all reports controlled by the print job, this means that the 
variable – in this example, the one controlling the printout of prices 
– must be named "chk1" in every report. This requirement must 
always be met; otherwise, contradictions might occur. To inform the 
user, the element created is displayed as inactive in the mask. 
 

Example: 

Report 1 includes a variable "chk1", which controls the printout of 
prices. Report 2 also contains a variable named "chk1". This variable, 
however, controls color printouts. If the relevant element created in 
the mask control of the print job is assigned the name "chk1", this 
element controls both the printout of prices and color printout. 
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Using the feed of the print job 

The print feed is defined in the same way as for an individual report. 
Controls specified in the individual reports are suppressed. 

 

 
 

Backing up and Restoring Reports 
The quick reports provided by Allplan BCM are usually installed 
along with the program files when you install Allplan BCM. You can 
re-import them anytime without having to run setup again. 

Reports you have newly created or modified can be backed up 
separately and restored when needed. 
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Backing Up Data and 
Archiving Projects 

Data backup is one of the most important topics in the IT industry. 
Even if you are working with large amounts of data without being 
confronted with any problems, it is a topic you cannot afford to 
ignore. Not only hardware failure, but also user error can cause 
valuable data to be lost irrevocably. It is therefore essential that you 
save all the data regularly, as otherwise several man hours, weeks or 
even months of work might be irretrievably lost. 

ATTENTION! 
Back up your master data, projects and other important data 
regularly! We also strongly recommend backing up all data before 
installing a program update! 

Various options are available: 

You can back up 

• all the data relevant to Allplan Quantities 

• specific projects using the Archive Administration tool 

• particular user-specific data (e.g. macros and filter conditions) 
using the Resource Administration tool 

• various other user-specific data (e.g. addresses, images, reports 
and settings) 

  

 

Full Backup 
The safest method is to perform a full backup, which includes all the 
data relevant to Allplan Quantities – ranging from projects, masters 
and element catalogs to data saved in the image and address 
databases to your own custom settings and definitions to reports you 
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have modified or created – in other words, all project-specific and 
user-specific data is backed up. 

You should always use this method to back up all the data at regular 
intervals. The other procedures described in the section entitled 
"Backing up User-Specific Data" should be used for exceptional 
cases only. 

  

 
 

Backing up and Archiving Projects Using the 
Archive Administration Tool 

In normal circumstances, you use the archive administration tool 
provided by Allplan Quantities to save and archive projects, item 
catalogs and element catalogs. This tool is also used to export 
projects from the current data directory or to import projects into 
this directory. 

When you are archiving a project, Allplan Quantities saves the 
project data in a directory you specify. The original project data in 
your current data directory is not affected by this operation so that 
you can continue to edit this project without any restrictions. As 
projects are archived in compressed format, they take up less space 
in the archive (only about 10% of the original space). 

In addition, Allplan Quantities’ archive administration tool offers the 
options to archive projects with password protection and to check 
out projects. When a project is checked out, it is saved in the archive 
directory and locked. As a consequence, the project in the current 
data directory it is no longer available for further editing. This way, 
you can make sure that this project is not being edited while it is 
checked out. More detailed information is provided in the section 
entitled "Access Rights for Archiving". 

You can use any directory that is accessible and shared for 
archiving. In other words, floppy disks or, when you are working in 
a network, directories on a central computer (= network server) can 
also be defined as archives. The number of archives is only limited 
by the amount of free space on the hard disk or by the floppy disk’s 
storage capacity. 
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Important! 
You can only save and archive projects in existing directories 
(= folders). If necessary, use Windows Explorer to create a directory 
before you back up data. 

  

 
 

Backing up Data Using the Resource 
Administration Tool 

You can use the resource administration tool to export user-specific 
data from the current directory to any archive and to import it from 
any archive into the current directory. The resource administration 
tool is a useful addition to Allplan Quantities’ archive 
administration, which allows you to back up/archive and restore 
project-specific data. 

  

Here, the term "resources" encompasses in particular 

• conditions defined for analyzing and evaluating data sheets (cf. 
Analyze Data Sheet), 

• conditions defined for modifying column contents (cf. Change 
Column Contents), 

• conditions defined for organizing, filtering and selecting data 
records (cf. Organize and Filter), 

• predefined or user-defined macros (cf. Macros) and 

• existing notes (cf. Pin Board). 

 

When you open the Resource administration dialog box by clicking 
the Administration of resources tool on the menu, you can edit all 
resource types. When you open the dialog box by clicking the 
Administration button in any of the dialog boxes listed above 
(either directly or via the Selection of libraries dialog box), only the 
resources of the current resource type are displayed. In that case, the 
display is automatically filtered based on the resource type; this filter 
cannot be modified. 
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Backing up Other User-Specific Data 
Here, the term "user-specific data" encompasses all the data that you 
can create, modify or define while you work with Allplan Quantities 
and that is not managed by the archive administration tool. This 
data includes addresses (see ""Address Overview" Data Sheet" on 
page 42) stored in the address database and objects (see ""Image 
Overview" Data Sheet" on page 44) in the image database. 

If you have customized default settings or data sheet settings, it is 
advisable to regularly create backups of those files, as well. Which 
files need to be included in backups is described in detail later in this 
section. 

Reports modified or created using the report designer should also be 
backed up regularly; this is particularly important before you install 
a program update. 

  

 
 

Back up and Restore the Address Database 

To back up address data 

1 Exit Allplan Quantities. 

2 Copy the ADRESS.DBF, ADRESS.FPT and ADRESS.CDX files 
in the directory ...\Allbase\Daten\Adressen to a 
backup directory or floppy disk. 

  

To restore address data 

1 Exit Allplan Quantities. 

2 Copy the ADRESS.DBF, ADRESS.FPT and ADRESS.CDX files 
from your backup directory to the 
...\Allbase\Daten\Adressen directory. 

ATTENTION! 
This operation replaces all the addresses currently stored in the 
address database with the addresses from the backup files! 
 

Tip: You can make your data 
sheet settings or column 
definitions available on a 
different computer. All you 
need to do is copy the 
specified files to the 
corresponding directories on 
the destination computer. 

Tip: You can also transfer 
reports to a different 
computer. How this is done is 
also described in this section. 
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Back up and Restore the Image Database 

To back up objects 

1 Exit Allplan Quantities. 

2 Copy the BILD.DBF, BILD.FPT and BILD.CDX files in the 
directory ...\Allbase\Daten\Verw to a backup directory or 
floppy disk. 

  

To restore the objects 

1 Exit Allplan Quantities. 

2 Copy the BILD.DBF, BILD.FPT and BILD.CDX files from your 
backup directory to the ...\Allbase\Daten\Verw 
directory. 

ATTENTION! 
This operation replaces all the objects currently stored in the image 
database with the objects from the backup files! 

 
 

Export/Back up and Restore Default Settings 

To back up default settings 

1 Exit Allplan Quantities. 

2 Copy the EDITORS.DBF, EDITORS.FPT and EDITORS.CDX 
files in the directory ...\Allbase\Daten\Verw to a backup 
directory or floppy disk. 

  

To restore the default settings 

1 Exit Allplan Quantities. 

2 Copy the EDITORS.DBF, EDITORS.FPT and EDITORS.CDX 
files from your backup directory to the 
...\Allbase\Daten\Verw directory. 
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Export/Back up and Restore Data Sheet Settings and Column Definitions 

To export or back up settings and column definitions 

1 Click Scheme on the Extras menu. 

The Scheme dialog box appears. 

2 In the Scheme list box, select to the scheme you want to 
export/back up. 

3 Click  Export scheme. 

4 Select the target directory in the Save as dialog box. 

5 Click Save. 

  

To restore settings and column definitions from backup 
files 

1 Click Scheme on the Extras menu. 

The Scheme dialog box appears. 

2 Click  Import scheme. 

3 Specify the source directory in the Open dialog box. 

4 Select the relevant scheme and click Import. 
 

 

Export/Back up and Restore Toolbars 

To export/back up a toolbar 

1 Close all the data sheets. 

2 On the Extras menu, point to Customize and click Office. 

The Configure office toolbars dialog box appears. 

3 Click  Export toolbar. 

4 In the Save as dialog box, select the target directory and enter a file 
name, if necessary (leave the *.ART file extension unchanged). 

5 Click Save. 

  



 

Integrated solutions  Backing Up Data and Archiving Projects 169 
 

To restore a toolbar from backup files 

1 Close all the data sheets. 

2 On the Extras menu, point to Customize and click Office. 

The Configure office toolbars dialog box appears. 

3 Click  Import toolbar. 

4 In the Open dialog box, set the path to the folder containing the 
toolbar (e.g. <dvd>\programs\Allplan 
BCM\Service\AddOn\CadObjekt) and select the *.art file. 

5 Click Import. 

6 In the Configure office toolbars dialog box, activate the Current 
check box. 

7 Click Close. 

8 Click Yes to confirm the prompt. 

The toolbar is added to the list of available toolbars. 

 
 

Export/Back up and Restore Reports 

To export/back up a report 

1 Open or activate the data sheet with which the relevant report is 
associated. 

2 Click  Print on the File menu and select No if asked if you 
want to recalculate everything. 

The Print dialog box appears. 

3 Choose a report edition in the Report templates list box and 
select the report you want to use. 

4 Click Export on the Edit menu. 

5 Select the target directory you want to use for archiving in the 
Browse for folder dialog box. 

6 Click OK. 
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To restore a report from backup files 

1 Click  Print on the File menu. 

The Print dialog box appears. 

2 In the Report templates list box, select the report edition into 
which you want to import the reports. 

3 Click Import on the Edit menu. 

4 Select the directory containing the reports to be imported in the 
Browse for folder dialog box and click OK. 

The Import reports dialog box appears. 

5 In the Group list box, choose the report group into which you 
want to import the reports. 

6 Select the report(s) in the Import reports dialog box. 

7 Click OK. 

Note: You can also restore the original standard reports provided by 
Allplan Quantities. How this is done is described in detail in the 
section entitled "Restore Standard Reports". 
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